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Part 1 Introduction

The Allworx System Software Version 8.2 is an application for Allworx administrators to configure and
manage Allworx servers with the following settings:

. Phone System
. Network

. Servers

. Reports

. Maintenance

The Allworx server web administration interface has built-in descriptions, help, and tips on many of its
pages. Additional documents related to Allworx System Software and Allworx applications:

. Allworx User's Guide, Release 8.2

. Allworx System Software Release Notes, Release 8.2
. Allworx Advanced Multi-Site Guide, Release 8.2

. Allworx Phone Guides

. Multi-Tech FaxFinder Setup Application Notes 8.2
. Allworx SNMP User’s Guide

. Allworx Interact and Interact Professional User's Guide
. Allworx Reach User's Guide

. Allworx OfficeSafe Operations Guide

. Allworx View Installation Guide

These publications as well as System Administrator’'s Guides for Releases 8.0 and lower are available on
the Allworx Partner Portal (www.allworxportal.com).

1.1 Who Should Read this Guide

This guide is for Allworx administrators that:

. install and maintain Allworx servers.

. understand computer networking and basic telephony.

. completed the Allworx Partner technical training.

1-866-ALLWORX * 585-421-3850 Page 1
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1.2 Guide Organization

The Allworx Server Administrator's Guide describes:

. requirements necessary to perform the operations described within the document.

. steps necessary to install, log in, and configure the Allworx server. To view the mounting,
electrical connections, and input/out accessories of the Allworx server, see the Allworx Server
Installation Guide specific to the Allworx server model.

. steps necessary to manage each web administration page to configure the Allworx server. Each
web administration page is a separate chapter within this document.

1.3 Equipment Requirements

The table below is a complete list of equipment and requirements necessary to perform all operations
identified in this Administrator’s Guide.

Equipment Requirements

PC * Running OS (with latest service pack).
+ Windows 7 32-bit SP1 + Windows 8/8.1 32-bit + Windows 10 32-bit
« Windows 7 64-bit SP1 « Windows 8/8.1 64-bit + Windows 10 64-bit

« RAM minimum: 2 GB.
» Monitor resolution: 1024 x 768 (XGA).
* Internet connection.

Allworx server « Allworx System Software Version 8.2.
« Administration permissions and passwords for each Allworx server.
« IP Address or DNS name of each Allworx server.

Allworx Partner Portal + Login permissions and password.

Supported Web Browsers + Microsoft Edge
« Microsoft Internet Explorer 11 (latest release with auto upgrade enabled).

« Google Chrome (Latest Release).
» Mozilla Firefox (Latest Release).

Allworx Server Installation Guide  The guide is specific to the Allworx server model that describes the mounting, electrical
connections, and input/output accessories of the Allworx Server. This guide is available at: https://
allworxportal.com/.

Allworx System User Guide The guide is specific to My Allworx Manager and describes the features within the application. This
guide is available at: https://allworxportal.com/.
Allworx Multi-Site Guide The guide describes the advanced set up configurations for multi-site networks. This guide is

available at: https://allworxportal.com/.
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1.4 Prerequisites

Each chapter of this document includes a Prerequisites table:

Access Permissions Identifies features that users with assigned roles can access and manage. The Allworx Server
Administrator can assign roles to a specific user on the Phone System > Users page. See “Roles”
on page 3 for more information.

Required Feature Key Identifies add-on features that are available as a separate purchase from the base feature set for
Allworx servers. See "Feature Keys” on page 219 for more information.

1.5 Roles

The available user roles include:

. Server Administrator: predefined system administrator with access to manage all functions of
the server. The Allworx Server Administrator assigns roles, manages the server administrative
functions, manages day-to-day phone system settings, manages the network and VolIP settings,
and initiates system backups and/or restarts.

. System Administrator: access to manage the administrative functions of the server. The user
permission setting does not enable this role to change the password of the Allworx Server
Administrator. However, the Allworx Server Administrator can change the password of the
System Administrator.

. Phone Administrator: access to manage day-to-day phone system settings including changes
to system recordings as well as adding, changing, and deleting users, extensions, and handsets.

. Network Administrator: access to manage the Network and VolP settings, as well as SIP
proxies and SIP gateways outside lines.

. Support Technician: access to initiate system backups and restarts as well as managing logging
operations.

Note: To enable one user to have roles on different servers in a multi-site network, the Allworx administrator must create
: separate user accounts for the user on each server, and then assign the roles on each server. Use different usernames
for each user account.

N . The Allworx administrator can assign users to manage queue and Auto Attendant recordings. See “"User Template
ote: e : .
Settings” on page 136 for more information.

. The Allworx administrator can assign users to manage individual queue settings or queue supervisor. See "User
Note: N ; .
Template Settings” on page 136 for more information.

1-866-ALLWORX * 585-421-3850 Page 3
www.allworx.com
Revised: 12/21/2016



Section 1 - Introduction e allv@®

Page 4 1866 ALLWORX * 1 585 421 3850
www.allworx.com
Revised: 12/21/2016



e allv@ Allworx System Administrator Guide Version 8.2

Part 2 Allworx Server Set Up

The Allworx Server Set Up section describes the

. . . . Prerequisites
installation and configuration procedures for the g

Allworx server. Additionally, this section describes ~ Access Permissions Allworx Server Administrator
the Allworx System Software compatibility of each s stk T ol

Allworx server. Feature Key Required No

2.1 Allworx System Software Compatibility

Allworx Server Model Connect Server Model

6x12| 6x | 24x | 48x | 320 | 324 | 530 | 536 | 731

Allworx System Software

System Software 7.7 and lower

System Software 8.0 X X X

System Software 8.1 and higher X X X X X X X X

2.2 Allworx Server Features and Compatibility

Allworx Server

Model Connect Server Model

6x12| 6x | 48x | 320 324 530 536 731

Hardware Support

Enhanced Diagnostic Port X X X X X
Network Ports 2 2 2 2 2 3 3 3
External USB Disk Drive Support X X X

Supported Web Browser

Microsoft Internet Explorer 11 X X X X X X X X
Google Chrome (latest version) X X X X X X X X
Mozilla Firefox (latest version) X X X X X X X X
Microsoft Edge X X X X X X X X
1-866-ALLWORX * 585-421-3850 Page 5
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AIlet\anr: dSe(irver Connect Server Model
6x12| 6x | 48x | 320 324 530 536 731

Allworx System Software 8.2 Support

Verge 9300 IP phone series X X X X X X X X

Expanded set of Ring Types X X X X X X X X

Handoff between Reach and Verge IP phones X X X X X X X X

Reach Remote Control X X X X X X X X

Sharing Personal Contacts with all of user’s Allworx X X X X X

devices and applications

Maximum number of Personal Contacts with 1,100 1,100 | 1,1,100 | 1,100 1,1,100

images per user.

Maximum number of Personal Contacts without 7,000 | 7,000 | 7,000 | 7,000 7,000

images per user.

Total number of Personal Contacts with images per 24,000 | 24,000 | 60,000 | 60,000 | 215,000

server (approximate).

Total number of Personal Contacts without images 144,000 | 144,000 | 360,000 | 360,000 | 1,290,000

per server (approximate).

Allworx System Software 8.1 Support

Five- and six-digit dialing® X X X X X X X X

Number of Auto Attendants Supported 9 16 32 16 16 32

Supports 2000 DID Blocks X X X X X X X X

Telnet Support X X X

Allworx System Software 8.0 Support

SSH Support X X X X X

Allworx Server Features

FXO Ports 6 6 3 0 4 0 6 2

FXS Ports 5 5 2 2 2 2 2 2

T1 Ports 2 0 0 0 0 1

Base System Extensions Limit 12 30 48 12 12 30 30 30

Maximum System Extensions Limit’ 12 60 250 20 20 50 50 180

Base Users 12 30 48 12 12 30 30 30

Maximumm Users’ 12 | 60 | 250 | 20 20 50 50 180

Maximum Handsets 24 120 500 40 40 100 100 360
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Allworx Server

Connect Server Model

Model

6x12| 6x | 48x | 320 324 530 536 731
Maximum External Calls 12 12 30 30 60
Conference Bridges' L L 4 L L 1 1 4
Maximum Total Bridge Users 8 8 8 8 8 8 8 30
Maximum callers in all conferences combined 8 8 60 8 8 8 8 30
Maximum Calls in All Queues’ 16 16 64 12 12 30 30 60
Maximum Calls per Queue' 8 8 16 12 12 30 30 60
Maximum Number of Queues' 10 10 10 10 10 10 10 10
Automatic Call Distribution’ No Yes Yes No No Yes Yes Yes
Auto Attendant Ports 9 9 9 4 4 8 8 16
Multi-Site Controller’ No Yes Yes Yes Yes Yes Yes Yes
Maximum Servers in a Multi-Site Network 99 99 99 99 99 99 99
Maximum Multi-Site System Extensions® 1000 | 1000 | 1000 | 1000 1000 1000 1000 1000
Maximum Multi-Site Users® 1000 | 1000 | 1000 | 1000 1000 1000 1000 1000
Voicemail Ports 8 8 16 4 4 8 8 15
Activation Required X X X X X
Secure Web Page Access X X X X X
Enhanced Codec Support X X X X X
SIP-Video Pass-Through 2 X X X X X
PPPOE X X X

lines configured.

on each Allworx server.

(minimum).

1 Requires an Allworx software feature key.

2 A SIP endpoint that supports video can register with the Allworx Connect server, and it supports negotiation of
video calls with that device. The Allworx Connect server supports up to two video sessions and one audio
session per call. The Allworx Connect server supported codecs are: H263, H264, and MP4V-ES.

3 The total external SIP calls are limited to the Maximum External Calls less any TDM (FXO ports and T1 channels)

4 The total number of Multi-Site Users and Multi-Site System Extensions varies upon the maximum users licensed

> Compatible with Reach for Android/Reach for iOS Version 2.0.7 (minimum) and Interact/ Interact Professional 2.3

1-866-ALLWORX * 585-421-3850
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2.3 Verge IP Phone Series Software Compatibility

The Verge IP phone series requires the following minimum software versions:

Product/Resource Version (or later)
Allworx System Software 8.2
Interact Professional 3.0
Reach for Android 3.0
Reach for iOS 3.0

2.4 Install and Configure the Allworx Server

To install the Allworx server:
1. Use the Allworx Server Installation Guide for mounting, electrical connections, and optional
input/output accessories specific to the Allworx server model.

2. Plug the PC into the server LAN port (ETHO on Connect servers), and set up the network
interface on the PC to obtain an IP address automatically (using DHCP).

(0 1) Instruction

Windows 7 Click Start and navigate to the Control Panel.
Locate View by: select Small Icons from the drop-down list.
Double-click Network and Sharing Center.
Click Change adapter settings in the left column.
Right-click Local Area Connection > Properties.
OTE: For wireless computers, select Wireless Network Connection > Properties.
Click Internet Protocol Version 4 (TCP/IPv4) > Properties.
Click Obtain an IP Address automatically and Obtain DNS server address automatically.
Click OK to save the changes.

GNOZUuhhwWN =

Windows 8 /
Windows 10

Click Start and navigate to the Control Panel. In the search box, type adapter.

Click Network and Sharing Center, and then click View network connections.

Locate and right-click the connection to change, and then click Properties.

(Optional) If prompted, enter the administrator credentials and confirm.

Click the Networking tab, and then click Internet Protocol Version 4 (TCP/IPv4) or Internet Protocol
Version 6 (TCP/IPv6) > Properties. Specify the address settings:

IPv4 Click Obtain an IP address automatically, and then click OK.

vhwn =

IP v6 Click Obtain an IPv6 address automatically, and then click OK.
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3.

Verify the PC has an IP address on the 192.168.2.x network. It may be necessary to release and
renew the IP address on the PC to get an address from the server.

a. Click Start and type cmd in the Search field. A command window opens. Type the
following to clear the PC current IP settings:

ipconfig /release

b. Press enter to clear the PC current IP settings. Type the following to obtain a new IP
Address:

ipconfig /renew
C. Press enter.

Use a web browser via the LAN interface on TCP port 8080 (8443 on Connect servers) to access
the administrative interface of the Allworx server. Enter:

Server URL
Allworx 6x, 6x12, 48x server http://192.168.2.254:8080
Connect servers https://192.168.2.254:8443 (Entering a URL of http://192.168.2.254:8080

redirects to https://192.168.2.254:8443.)

Log in to the web admin page using admin as the username and password. The Allworx server
admin page displays the factory default settings at first log in and displays the customized
settings with any subsequent log in.

The server is ready for configuration.

To configure the Allworx server:

1.

2.

3.

Log in to the web admin page using admin as the username and password.
Locate the left side of the web admin page and click Install Checklist.
Follow the order of the steps of the Install Checklist for a successful configuration. Check the box

on the web admin page next to each step to avoid duplication. The Install Checklist table below
links to the appropriate System Administrator’s Guide chapter to configure the server.

Install Checklist

Step Description Allworx Server Admin Guide Link
1 Set time on server. “Time” on page 237
1-866-ALLWORX * 585-421-3850 Page 9
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G alivworx

Step Description Allworx Server Admin Guide Link
2 48x and Connect 731 servers only: Program Digital Lines. If “Digital Lines” on page 147
connected to T1 interface(s), configure the system to match
the settings obtained from the service provider.
3 Program Network configuration: “Configuration” on page 143
1. Network Mode
2. VLAN settings
3. Public Interface
4. Gateway
5. Server Host Name
6. Domain Name
7. Firewall Settings
4 Enable/Disable DHCP server. “DHCP" on page 169
5 Set DNS server addresses. “DNS" on page 171
6 Optional: Configure Port Expanders "Px Expanders and Remote Phones” on page 157
7 Enable VPN, if required. "Virtual Private Network (VPN)" on page 165
8 Restart server for settings to take effect. “Restart / Shutdown" on page 233
NOTE: After restarting the server, close this window, and then
re-open it after logging into the server.
9 Activate server with Portal, if required. "Registration” on page 231
10 Download/enter the required Feature Keys. "Feature Keys” on page 219
1 Update the Allworx server to the latest software release, if “Update” on page 243
required.
12 Optional: Configure use of Primary and Secondary “Languages” on page 87
Languages.
13 Define the Internal Extension Length and Internal Dial Plan. “Manage the Internal Extension Length” on page 37
“To manage the Internal Dial Plan:" on page 39
14 Add users. Associate handsets to users, if available. “Manage Users” on page 131
15 Add handsets. Add the Analog and SIP Handsets using Plug ~ “"Manage Analog Handsets” on page 61
and Play or manual programming. Once programmed, check  “Manage Allworx and Generic SIP Handsets” on page 63
the phone by dialing #7 from any Auto Attendant Main Menu.
16 If live answering inbound calls, create a system extension and "Add New Extension” on page 55
preferred call routes. Use a Ring Group if live answer with line  "Ring Groups” on page 113
appearances on Allworx handsets is required.
If different sets of handsets need to ring depending on the
incoming line, give a descriptive name to a Ring Group, create
an extension for each incoming line, and route the call to the
Ring Group.;
Configure the Allworx handsets later to use the Ring Group(s)
defined in this step.
17 Define additional system extensions used for routing to "Add New Extension” on page 55
groups or places such as conference rooms.
18 Optional: Create and define Call Queues “Call Queues/ACD" on page 27
Page 10 1866 ALLWORX * 1 585 421 3850
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Step Description Allworx Server Admin Guide Link

19 Optional: Define Paging Zones. Define the Paging Zones, add  "Paging” on page 109
Line Out or Handsets to the required zones.

20 Add/Configure Outside Lines to phone system (standard FXO “Outside Lines” on page 97
loops, SIP Gateways, SIP Proxies). Enable line appearances, if
required and define call routes.

21 Configure Allworx handsets by defining the programmable “Manage the Programmable Function Keys (PFKs)"” on

function keys (PFKs). page 68
22 Optional: Save the Allworx handset configuration as a “Manage Handset Templates” on page 79

template, and then apply to remaining Allworx handsets.
Modify individual handset configurations as required.

23 Program operator route (0). “Manage Call Routes” on page 58
24 Record Auto Attendant and Call Queue prompts, if required.  “Custom Recordings” on page 215
25 Set the Dial Plan for the system. Create special Service “Dial Plan” on page 37

Groups, if required, and then define the Dialing Rules.
26 Check handset permissions to access outside resources, if "Handsets” on page 61

required.
27 Enter business contact information and schedules. “Business Information” on page 23

“Schedules” on page 123

28 Check system: N/A

1. Make 3 to 4 inbound calls (e.g., use cell phone to call the
Allworx server).

2. Make outbound local and long distance calls to several
area codes.

L

29 Configure Email server. "Email” on page 173
1. Leave incoming WAN email forwarding disabled, unless
server is within firewall!
2. Enter alternate email domains.
3. Enter spam blocking services (e.g., spamhaus.org)

30 Enable VPN for additional users, if required. “Manage Users” on page 131
31 Create aliases for email/voicemail distribution lists. "Message Aliases” on page 91
32 Set up and perform a backup using OfficeSafe “Backup” on page 213

33 Deliver user documentation (Welcome sheet, Allworx User’s

Guide, and Allworx Phone Guides) and conduct basic training
for each user.
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Part 3 Phone System

The Phone System sections describe the setup and management of the Allworx server specific to the
business requirements. Each chapter explains:

. necessary access permissions and feature keys,
. necessary equipment to perform the procedure, and
. necessary procedures to manage the Allworx server feature.

The various Phone System pages on the server web admin site enable the Allworx administrator to set
up, configure, and manage the settings of the following features:

Page
AuditPINCode - - - - - - - - = - - - - - - - - - - - - - - - - s s - - 15
Auto Attendants - - - - - - - - - - - - - - - oo oo o s s s s s s s 17
Business Information - - - - - - - - - - - - - - - oo oo oo oo s 23
Call Park - - - = = = = = = = = = = = = oo e s s s s s - s - - 25
CallQueues/ACD - - - - - - = = = = = - - - - - - - - - - - - - - - - - - - 27
Conference Center - - - - - - = = = = = = = = = - - = - - - - - - - - - - oo - 35
DialPlan - - - - - - - = - - - - - - - - oo - - oo s s s s s s s 37
Emergency Alertsand CallerID - - - - - - - - - = - - - - - - - - - - - - oo oo oo 51
Extensions - - - - - - - - - - - - - - - oo oo s o s s s s s s s s s s s 55
Handsets - - - - - - - - - - - - - - - - - - - - - oo s s s 61
Languages - - - - - - - - - - - - - - - - - oo - o oo oo s oo o oo - - - - 87
Message Aliases - - - - - - - - = - - - - - - - - - - - - - oo - oo m s s - - - 91
MusicOnHold - - - - - - - - - - - - - - - - - - oo - s s e 95
Outside Lines - - - - - = = - = = = - = - - - - - - - - - - - - - - oo - - - - - 97
Paging - - - - - - - - - - - - - - - - - - - - - s s s o s s - s s s s s - s - 109
PublicContacts - - - - - - - - - - - - - - - - - - - - - - - - oo 111
Ring Groups - - = - - = = = = = = = - = - - - - - - - - - - - - - - - - - - - - - 113
Roles - - - = = = = = = = = = = = o - o oo — o oo oo oo oo s s o - - - - 115
Schedules - - - - - - - - - - - - - - - oo oo oo s s s s s s s 123
Shared Call Appearance - - - - - - - - = - - - - - - - - - - - - - - - - - - - - - -~ 127
Users - - - = = = = = = = = = = = = - - - - - - m s s s s s m s - - - s s s 131
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Chapter 3  Audit PIN Code

Audit PIN Code supports call tagging and -
controls outside line access. The Audit PIN Code = Prerequisites
does not support outside line access when using
a Line Appearance PFK.

Access Permissions Allworx Server Administrator
Allworx System Administrator
Phone Administrator role

Example:
Feature Key Required No
A company charges customers for the tolls and
time spent on each call.
To use tagging to properly bill each customer:
. The Allworx administrator assigns each project a unique PIN code.
. The phone user dials 78" + <PIN code specific to the project> + <phone number> to access the
outside line to work with the customer.
. The Accounting Department uses the PIN code from the call records to bill each customer.

To specify the number of digits and the service group used by the Audit PIN Code, see "Manage the
Services” on page 46 for more information.

To manage an Audit PIN code:
1. Log in to the Allworx server admin page, navigate to Phone System > Audit PIN Codes, and
locate the Audit PIN Codes section.

2. Click one of the following links:
add new Enter the new PIN code and description in the respective fields, and then Click Add to save the changes
PIN code or Cancel to disregard the request.

To change the PIN code length, see “Manage the Services” on page 46

Modify Change the current PIN code and description. Click Update to save the changes or Cancel to disregard
the request.

Delete The server removes the PIN code from the list.
1. Confirm this is the PIN code to remove.
2. Click Delete to remove the user from the list or Cancel to disregard the change.

To enable or disable the Audit PIN Code Verification:
1. Log in to the Allworx server admin page, navigate to Phone System > Audit PIN Codes.

2. Locate the Audit Pin Code Configuration section and click modify.

1. Extensions may vary per system. If using a non-default Internal Dial Plan, consult the My Allworx Manager Phone
Functions tab to determine what extensions to use for the corresponding feature.
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3. Select one of the following options from the drop-down list:
Enabled The Allworx server verifies that the PIN code is the correct length and loaded in the PIN code list on
the Allworx server.
Disabled The Allworx server only checks for the correct PIN code length.
4. Click the Update button to save changes or Cancel to disregard the request.

Click here to return to the Install Checklist .
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Chapter 4 Auto Attendants

Auto Attendants answer incoming calls -
automatically, and then directs the callers to the | Prerequisites
appropriate person or department using the

: : Access Permissions  Allworx Server Administrator
dial-by-name or company phone directory. Allworx System Administrator

Phone Administrator role

Each Auto Attendant supports the Open and
Closed greeting and up to seven custom Feature Key No

greetings and one custom message for each Required

Auto Attendant with a length limit of 15 minutes

per greeting or message. Users with permissions to record and manage custom Auto Attendant
greetings and messages and can assign each Auto Attendant to a different schedule. See "Number of
Auto Attendants Supported” on page 6 for the number of Auto Attendants each Allworx server
supports.

Example: use one Auto Attendant to answer calls for Sales and another Auto Attendant to answer calls
for Support. Each Auto Attendant plays a greeting specific to the assigned department.

4.1 Setup Checklist

Follow the order of the steps to successfully setup the Auto Attendant.

Step Description Installation Guide Link
L Configure the Auto Attendant. “Configure the Auto Attendant” on page 17
2 Create an extension and/or assign the Auto Attendant to an outside "Extensions” on page 55 or “Manage Analog
line, and then update the call route to the Auto Attendant. Central Office (CO) Lines” on page 98
3 Record the custom greetings and messages for each Auto Attendant.  “Record Auto Attendant Greetings and

Messages” on page 20

4 Configure the Auto Attendant greetings to change, per time of day. “Schedules” on page 123

4.2 Configure the Auto Attendant

To configure an Auto Attendant:

1. Log in to the Allworx server admin page, navigate to Phone System > Auto Attendants. The
Auto Attendants display with the assigned extension (4301 to 43xx" - where xx is the maximum
number of Auto Attendants supported by the Allworx server) and Auto Attendant number.

1. Extensions may vary per system. If using a non-default Internal Dial Plan, consult the My Allworx Manager Phone
Functions tab to determine what extensions to use for the corresponding feature.
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2. Locate the Auto Attendant and click the additional information arrow w», if necessary. Click one
of the following links:

modify

Change the Auto Attendant configuration. Select the settings to update in the drop-down list. See "Auto
Attendant Configuration Settings” on page 18 for more settings information.

reset

Change the configuration to the factory defaults. Select an option:
 Reset to default settings, but keep all custom recordings

« Delete all custom recordings

+ Reset to default settings AND delete all custom recordings

Click Reset to update the settings or Cancel to leave the settings as is.

3. Click Update to save the settings or Cancel to disregard the request.

Auto Attendant Configuration Settings

Features and Prompts

Description

Enter description of the Auto Attendant.

Schedule

Select the schedule created for switching greetings. See “Schedules” on page 123 for more information.

Include Remote
Users

For multi-site networks - includes users from other sites in Dial-By-Name.
+ Enabled
» Disabled (Default)

Dial-By-Name Menu
(#1)

Enable callers to select an Allworx user by typing the user’s name based on the setting in the Dial-By-Name Spell
Option field.

« Enabled

» Disabled (Default)

Dial-By-Name
Prompt

Prompt: Press 1 to dial by name.
* Do not play
« Play (Default)

Dial-By-Name Spell
Options

Select the spelling method for the Dial-By-Name option.
« spell first or last name

« spell last name

« spell first name

Dial-By Directory
Menu (#2)

Enable the caller to listen to a list of users and extensions, and then enter an extension.

« Disabled

« Enabled (Default)

Note: The system automatically disables Dial-By-Directory if there are more than 50 users assigned to the Auto
Attendant

Dial-By-Directory
Prompt

Prompt: Press 2 for a listing of all users and extensions.

* Do not play

« Play (default)

Note: The system automatically disables Dial-By-Directory if there are more than 50 users assigned to the Auto
Attendant.

Dial-By-Directory List
Order

Controls the order in which the directory is spoken.
« List in extension order
+ List in name order

Dial It Now Prompt

Prompt: If you know your party's extension you may dial it now.
« Do not play
« Play (default)

Page 18
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Repeat Menu
Behavior

Identifies what repeats when requested by the caller.
« replay Custom Message only

« replay Greeting Only

« replay Greeting and Custom Message

Repeat Options
Prompt

Prompt: Press * to listen to these choices again.
+ Do not play
- Play (default)

Speed Dial Numbers

(support for dialing 350-399, 34000-34999" from main menu)
(listed as *250-*299 AND *24000-*24999)

« Allowed

» Not Allowed (default)

Day Mode Menu
Shortcuts

Night Mode Menu
Shortcuts

Identifies if users can dial the Menu Shortcuts in Day or Night Mode for each Auto Attendant.
» Allowed (default)
+ Not Allowed

Day Mode Internal
Call Restriction

Night Mode Internal
Call Restriction

Restricts what internal calls can be made from each Auto Attendant based on the day mode.
 Auto Attendant Default - blocks all calls except the following (examples are from the Default Dial Plan, 3-digit,
not using extension mode):

» Operator (x0)

» Conference Center (x408)

« Other Auto Attendants (x400, x43n)

 Call Queues (x44n)

» Message Center (x404)

» User and System Extensions (x1nn, x2nn)

+ Speed Dial 3 and 5 digits (x350-300, x34nnn)

+ Leave a message (x3 + user extension)

» Message Center for user (x6 + user extension)
« <List of available restrictions>

After

Select the number of seconds (1 to 15) with no input, and then indicate the next step.
* Replay Menu
« Transfer to <select an extension/user>

Menu Shortcuts

The Allworx administrator can configure the Auto Attendant to enable dialing digits 0 through 9 as single-digit Menu Shortcuts. Dialing
the digit transfers a caller to a designated extension, another Auto Attendant, Dial-By-Directory, or Dial-By-Name.

To use the Dial-by-name or Dial-By-Directory option, enable the option and set the Dial-By-Name or Dial-By-Directory Prompts to Do
not play.

Day Mode Menu
Shortcuts

Select an option from the drop-down list:

« disabled - turns off the Menu Shortcuts option.

« enabled - select an extension in the drop-down list for the corresponding digit. The default assignment is ‘0 —
operator™ and does not provide the option of Dial-By-Directory or Dial-By-Name.

+ use Day Mode - the Menu Shortcuts are the same for both Day and Night Mode. Available on Night Mode
Menu Shortcuts only.

Night Mode Menu
Shortcuts

" Extensions may vary per system. If using a non-default Internal Dial Plan, consult the My Allworx Manager Phone Functions tab to
determine what extensions to use for the corresponding feature.
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4.3 Record Auto Attendant Greetings and Messages

Auto Attendants play built-in or custom greetings and messages. Users with Recording Manager
permissions can record the greetings Offline up to 15 minutes in length, and then import the greetings
into the system see "To import/export greetings and messages:” on page 21 for more information. Or,
record up to nine greetings and one custom message for each Auto Attendant using the Message
Center on the phone.

To enable Recording Manager permissions, see “"To modify or delete existing users:” on page 133 and
update the following settings:

Roles Select System or Phone Administrator for access to Auto Attendants.

Recording Manager Select the specific Auto Attendants for the user.

The Allworx system plays the greetings, messages, and prompts in this order:

. Business schedule greeting — for the current time of day (See "Manage the Greetings” on
page 123.).

. Custom message (This does NOT change based on the business schedule)

. Other selected, built-in prompts.

. When routing a caller to an Auto Attendant after playing all prompts, if the caller presses * to hear the selections
Note: . . ; ;
again, the system skips the business schedule greeting.

To record a new greeting / custom message or manage the Auto Attendant schedule:

. To modify the greetings (Auto Attendant) or custom messages, the user (not the administrator) must have Allworx
Note: . o o
System Administrator or Allworx Phone Administrator role permissions.

. Allworx does not recommend using an Reach handset to record new greetings or queue messages as the ability of
Note: N . .

the server to record greetings is intolerant of network packet loss. As a result, recordings made via lossy networks
may have impaired quality. Local or wired networks are best for making these recordings.

Note: For systems with Dual Language Support: Users cannot change languages within the Message Center. To record new
: messages in a second language, select an option:

« Setup an account configured for the secondary language, and then record the greetings using that account.

« Temporarily modify the user’s default language to match the secondary language of the system.

1. Dial the Message Center extension (404").
2. Log in using the assigned extension and PIN code.
3. Press 9 to manage greetings, and then press 1 to manage the Auto Attendant.

1. Extensions may vary per system. If using a non-default Internal Dial Plan, consult the My Allworx Manager Phone
Functions tab to determine what extensions to use for the corresponding feature.
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4. Press the number corresponding to the Auto Attendant (4301 to 43xx' - where xx is the
maximum number of Auto Attendants supported by the Allworx server).

5. Press 1 to manage the greetings for the selected Auto Attendant.

a. Enter the number (0 through 8) of the greeting to record.

b. Press 2 to record a new greeting.
C. Record the new greeting and press ‘# when complete.
d. Press 1 to save the greeting.
6. Press 1 to record additional greetings or press # to go to the previous menu to manage other

Auto Attendants.

7. Press 2 to manage the custom message for the Auto Attendant.

Greeting Sample Script

Greeting 0 Welcome to <your company name>, your best source for <product>.

(Open) Dial 1 for store hours and directions. Dial 2 for Sales. Dial 3 for Service. Dial 0 to reach the operator.

Greeting 1 Welcome to <your company name>, your best source for <product>. We are currently closed, but we will

(Closed) re-open at <opening time>. Our hours are <hours of operation>. If you know your party’'s extension, you
may dial it now. You may also leave a message in our general mailbox at extension <number>.

Custom <Your company name> is the premier provider of <products>. We specialize in <specialty>. Our latest
product is...

To import/export greetings and messages:

Import the greetings and messages recorded off-line onto the Allworx system. The files use a specific
internal format and have a specific file name format - Example: aa#x.snd. The filename for the status
message for Auto Attendant 2 is “aa20.snd".

Digit Description

# Replace with the Auto Attendant number 1 through 9

X Replace with greeting number (0 through 9 - Use '0' for the Open greeting, '1' closed greeting) or “c” for Custom Message.

See "Custom Recordings” on page 215 for more information.

To manage the Auto Attendant schedule:
This option is only available to users with recording manager permissions on Allworx systems.

1. Log in to the Audio Message Center and press 9 on the numeric keypad.

1. Extensions may vary per system. If using a non-default Internal Dial Plan, consult the My Allworx Manager Phone
Functions tab to determine what extensions to use for the corresponding feature.
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2. Select option 1 (To manage the Auto Attendant), and then select the Auto Attendant (4301 to

43xx! - where xx is the maximum number of Auto Attendants supported by the Allworx server)
number to change.

3. Select option 3 (To manage the schedule). The following message plays, “The Auto Attendant is
using schedule <number>. To select a different schedule, enter the schedule number followed
by #."

4. Enter the schedule number, and then enter the # sign. After successfully selecting a different

schedule, the user hears, “The Auto Attendant has been changed to use schedule <number> "
The Message Center returns to the Manage Auto Attendant Menu.

If selecting a different schedule is unsuccessful, the user hears, “You must enter a valid schedule
number.” The Message Center returns to the Manage Auto Attendant Schedule Menu.

4.4 Assign the Auto Attendant to an Outside Line

The default Auto Attendant determines the setting when selected in the configuration of the outside
line. To assign the Auto Attendant to an outside line, see “Manage Analog Central Office (CO) Lines”
on page 98 for more information.

Follow the same procedure for any of the outside lines, including SIP Gateways and SIP Proxies.

Click here to return to the Install Checklist .

1. Extensions may vary per system. If using a non-default Internal Dial Plan, consult the My Allworx Manager Phone
Functions tab to determine what extensions to use for the corresponding feature.
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Chapter 5 Business Information

Business Information feature enables entering

information about the primary business contact. = Prerequisites
T - . . Access Permissions Allworx Server Administrator

Prowdlng this information is recommended but Ao Sysiem Adilsieiey
not required. Phone Administrator role
To manage the business information: Feature Key Required g
1. Log in to the Allworx server admin page,

and navigate to Phone System > Business Information. The Business Information page

displays.

2. Click Modify and enter the business information in the fields provided.

For activated Connect servers, there is an option to import the customer business information
from the registration information on the Portal.

3. Click Update to save change or Cancel to disregard the request.

Click here to return to the Install Checklist .
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Chapter 6 Call Park

Call Park feature places a call on a system wide

hold via a designated extension number and Prerequisites

retrieving the same call on any other handset. Access Permissions Allworx Server Administrator
Allworx System Administrator

Example: park a call from one office, and then Phone Administrator role

walk to another office to retrieve the call. Feature Key Required No

Allworx servers support up to 59 parked calls at one time using Parking Orbit extensions between 701
to 709" and 4950 to 4999" and assigns the parked call the lowest available Parking Orbit number.

To configure the Parking Orbit:
1. Log in to the Allworx server admin page, and navigate to Phone System > Call Park.

2. Click one of the following options:

Call Park > modify

Timeout (seconds) Enter a value in seconds for the call to timeout. Default is 600 seconds.
After timeout Sends the call to the next stop in the call route. Options include:
- Transfer caller to handset that parked call, on busy <select an extension from the drop-down
list>.

« Transfer caller to extension <select an extension from the drop-down list>. Default is the Default
Auto Attendant.

Multi-Site Parking > modify

Permit other sites Enables users at other sites to retrieve calls parked in its Parking Orbits.
to retrieve parked « The server must participate in Multi-Site Parking Orbits.
calls from this site. All sites that participate share 150 Multi-Site Parking Orbits at extensions between 4800 and 4949
« See the Allworx Advanced Multi-site User Guide for information on configuring Multi-site
parking.

1. Check the box to enable.
2. Enter the number of parking orbits to use per site. The Call Park page displays the Number of
Orbits and the Retrieve # for each site.

3. Click Update to save the changes or Cancel to disregard the request.

To configure the Allworx IP phone PFKs for parking orbits, see "Manage the Programmable Function
Keys (PFKs)” on page 68 for more information.

Click here to return to the Install Checklist .

1. Extensions may vary per system. If using a non-default Internal Dial Plan, consult the My Allworx Manager Phone
Functions tab to determine what extensions to use for the corresponding feature.
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Call Queues/ACD

Call Queues/ACD distributes calls to a specific set
of users.

The Allworx system manages and distributes the
incoming calls that are too numerous for agents

Prerequisites

Allworx Server Administrator
Allworx System Administrator
Phone Administrator role

Access Permissions

to answer immediately in a first-in-first-out Feature Key Required + Call Queuing
d + Automatic Call Distribution
oraer.
Note: The Call Queue feature works only with Allworx IP phones, no other manufacturer’s phones support this feature.
Note: Pressing the phone MUTE/DND button does not stop incoming queue calls.

Available features:

Provides feedback to call queues callers:

. greeting plays when calls enter the queue.
. configurable periodic status messages while waiting in the Call Queue.
. ringing for waiting customers to hear, as an alternative to the periodic status messages.

Using an Allworx IP phone, agents can:

. log in and out of queues.
. receive calls from or answer calls in a queue.
. monitor the status of the queues.

Configure the maximum wait time for a call before hanging up or transferring to: an Auto
Attendant, an extension, another queue, or a user's voicemail.

Exit the queue at any time by pressing zero. Different exit routes can be set up for each queue.

Statistics for all queues are available from My Allworx Manager, as an export file and streamed to
a PC on the network using a TCP streaming port number configured on the Allworx server.

Allworx server Call Queues/ACD support

Allworx Server Allworx Connect Server
6x12 6X 48x 320/324 | 530/536 731
Maximum calls in one queue 8 8 16 12 30 60
Total calls in all queues 16 16 64 12 30 60
Call queues X X
ACD queues
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7.1

Setup Checklist

€ allworx

Follow the order of the steps to successfully setup a Call Queue.

Step

Description

Installation Guide Link

Ring All Queue

1 Set the Distribution Mode set to Ring All. "To manage the Call Queues/ACD settings:” on page 29.
2 Assign Queue Appearance PFK to phones assigned/available  “Manage the Programmable Function Keys (PFKs)” on
to agents. page 68
3 Agents log in to queue with Queue Appearance PFK (by Allworx Server User Guide
default, Queue Appearance PFKs are set to automatically log
in when the phones start up).
4 (Optional) Assign the Queue Alarm PFK to any Allworx “Manage the Programmable Function Keys (PFKs)” on

phones.

page 68

Automated Call Distribution Queuing

5 Set the distribution mode to one of the ACD features. "To manage the Call Queues/ACD settings:” on page 29
6 Assign a user as queue supervisor (the admin user is a queue “User Template Settings” on page 136
supervisor).
7 Queue supervisor assigns agents to single or multiple queues Allworx Server User Guide
in My Allworx Manager.
8 Assign an ACD appearance PFK to the agent Allworx IP phone “Manage the Programmable Function Keys (PFKs)” on
(ACD queuing requires Allworx IP phones). page 68
9 (optional) Assign the Queue Alarm PFK to any Allworx
phones.
10 Agents log in to queue with ACD Appearance PFK. Allworx Server User Guide
11 Enable Call Queue supervisor permissions. “User Template Settings” on page 136

All Call Queues

12 Configure calls to route to a Call Queue. “Manage Calls to Route to a Call Queue” on page 32

13 Route the calls using an Auto Attendant to the Call Queue. “Route a Call using Auto Attendant to a Call Queue” on
page 32

14 View the Call Queue statistics. "Display Queue Statistics” on page 33

15 Record the custom greetings and messages for each queue.  "Record Queue Greetings and Messages” on page 33

16 Import the custom greetings/messages for each queue. “Import Greetings and Messages” on page 34

7.2 Set Up A Call Queue: Ring All

The Ring-All distribution rings all phones assigned a Queue Appearance PFK logged into the queue
simultaneously. If there are any callers pending in the queue, all available phones ring according to the
configured behavior. Caller ID information during inbound ringing and statistics related to specific
agents is not available.
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To place calls directly into the queue:
See "Extensions” on page 55. for more information about the steps below.

1. Create a system extension for each queue, such as a Customer Support system extension. Define
the call route to immediately transfer calls to the Customer Support queue.

2. Define the call route of the outside line to direct calls to the Customer Support system
extension.

7.3 Set Up An Automated Call Distribution Queue

Automated Call Distribution Queues use any of the other available distribution features, and directs
each call to a specific agent with an assigned ACD Appearance PFK. The Allworx 6x12 and Connect 300
series servers do not support ACD queuing. The ACD Call Distribution settings include:

Linear Priority Distribute calls based on a prioritized list of agents. The queue supervisor sets the priority by assigning a unique

ranking to each agent. As each call comes in, it goes to the available agent with the highest priority ranking.
Sequential Distribute calls in a circular manner to the logged-in agents, and evenly distribute the calls so the agents have an
Round-Robin opportunity to answer approximately the same number of calls.

« Maintains a list of available agents. When a call gets to the front of the queue, the next agent on the list
receives it. When agents log in, they are put at the bottom of the list.

« After the last agent on the list receives a call, the distribution option returns to the top of the list. If the agent
in line to receive the next call is currently busy with another call, the call goes to the next agent on the list. The
busy agent that missed the call moves down the list of agents to receive the next call when they are available.

Fairness-Longest Distribute calls to logged-in agents that are idle for the longest time to evenly distribute the calls so that all
Idle agents spend approximately the same amount of time on calls.
« Maintains a list of all available agents. When a call gets to the front of the queue, the next agent on the list
receives it.
« Places agents at the top of the list after logging in. After completing a call, the agent moves to the bottom of
the list.

7.4 Manage Call Queues / ACD

To manage the Call Queues/ACD settings:
1. Log in to the server admin page and navigate to Phone System > Call Queues/ACD page.

2. Click one of the Call Queues / ACD options options:

manage Provides a short cut to the custom recordings settings played by the Call Queues. See “Custom Recordings”
on page 215 for more information.

View Provides a short cut to the Languages settings page. See “Languages” on page 87 for more information.
This feature is only available to Allworx Server or Allworx System Administrators.

3. Click the more information button ( ») to expand the queue. Click modify. Change the Call
Queue / ACD settings. See “Call Queue /ACD Settings” on page 30.

4. Click Update to save the updated Queue Streaming Settings or Cancel to disregard the request.
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5. Click modify to update the Queue Streaming Settings or the ACD Queue Busy Reasons. Click
the Update button to save the changes or Cancel to disregard the request.

Queue Streaming
Settings

Monitor the Call Queue statistics in real-time by streaming the data to a client application
connected to a specified TCP port on the Allworx service LAN interface.

« Provides a mechanism for the development of a third party wallboard application.

» To set up the streaming queue data:

1. Set the Queue Streaming field to:

« Do not stream Call Queue Data
» Stream Call Queue data

2. Set the Queue Streaming Port to the appropriate TCP port setting (1 through 65535; the default
is 16367).

When there is queue activity (e.g. callers enter, are serviced, exit queues, agent logs in or out, etc.)
the data streams. Each record is a complete XML file. See the Allworx ACD Statistics Collection
Internet Interface document for a complete definition of the record layout.

To receive and view this data, use a Telnet application (e.g., HyperTerminal) configured to log data
from the TCP port configured on the server for ACD data streaming. The client connections limit is
16.

ACD Queue Busy
Reasons

Change the ACD Queue busy reasons. Enter the Queue Busy Reason description in the available
field, and then restart the server for the changes to take effect.

Call Queue /ACD Settings

Description*

Textual description of the queue (e.g., Sales, Tech Support). The system displays this description in
other areas (e.g., Statistics, handset display screen, etc).

Distribution Mode - Ring All

Select the Call Queue: Ring All option.

Distribution Mode - ACD

Select any option except the Ring All option.
« ACD: Fairness - Longest Idle

 ACD: Linear Priority

» ACD: Sequential Round Robin

Replay Status Message

Enter a value (seconds) between successive status update messages. Entering zero (0) disables the
status message.

Maximum Wait

Enter a value (minutes) callers can wait in a queue; after exceeding this period the call to the
beginning of the queue. Entering zero (0) enables the caller to wait without a limit.

When queue answers call

Select the option for the caller to hear while waiting in the queue:
« Play queue prompts
» Do no play prompts (caller hears ringback)

Queue Depth Alarm Threshold

Enter a value (number of calls in the queue) to trigger the Queue Alarm PFK for yellow and red
alarm levels. Entering zero (0) does not trigger an alarm.

Wait Time Alarm Threshold

Enter a value (seconds) to trigger the Queue Alarm PFK for yellow and red alarm levels.

Hold Music Selection

Select the hold music source that callers hear while waiting in the queue from the drop-down list.

When caller leaves queue

Calls can exit the queue under any of the following conditions:

due to + Maximum wait time expired
« Queue is full
« Caller presses 0
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When caller leaves queue
due to (con't)

Click the more information arrow and select one of the following routes for each exit conditions:
* Hang up

« Transfer to extension <specify extension>

« Transfer to voicemail for user <specify user>

« Transfer to Call Queue <specify call queue>

ACD settings - only

Maximum Rings

Enter a value (number of rings) agents have to answer a call. If the agent does not answer the call
before the maximum number of rings, the system sets the agent to unavailable (No Answer), and
the call returns to the front of the queue. The call rings the next available agent.

NOTE: the system does not log out agents for not answering calls from an ACD queue even while
on another call.

Wrap Up Time*

Enter a value (seconds) the agent has available after ending a call before the system makes the
agent available to receive subsequent ACD queue calls. Agents can dismiss/end the wrap up time
from the handset. Reboot the agents phones to apply changes to wrap up time.

When no agents are
logged in

Select the option for callers entering the queue:
* Force callers to leave queue immediately
« Allow callers to wait in queue

When calls are received with

all agents busy

Select the option for callers when agents are unavailable:
« Allow callers to enter queue
« Don't answer, treat as if caller left queue

When all agents are in
No Answer state

Select the option for call when all agents are unavailable due to the No Answer state:
« Force callers to leave queue immediately
« Allow callers to wait in queue

Last Agent in queue

Select the option for the last agent:

* Is allowed to logout of queue

« Is NOT allowed to logout of queue

NOTE: If the last agent servicing a queue does not pick up a call within the maximum number of
rings, the system sets the agent to unavailable (No Answer). Queue Supervisors can log any agent
out, regardless of this setting.

Distribute calls to busy
handsets

Select to enable or disable distributing calls to agent handsets that are currently busy with non-
ACD calls. A busy handset is an agent handset any active call.

Play greeting before call
distribution

Select enabled for calls to wait for the greeting message to complete if an agent is available or
disabled to distribute calls immediately upon entering the queue. In either case, the messages play
until the agent picks up the call.

Queue Priority

Select a lower number to indicate a higher priority. When an agent is logged into more than one
queue, the next call comes from the highest priority queue where calls are waiting.

For example, if the VIP Queue has priority 0 and the Support Queue has priority 3, the agent
always gets calls from the VIP Queue first. The only time a call from the Support Queue goes to the
agent is if the VIP Queue has no calls. Queues that have the same priority function the same way as
previous releases.

Agents

Click show to view and assign agents to the Call Queue. Also sets the order of linear priority
distribution mode. Click hide for no display.

* Agent must log out and back into the Queue to use the new value.

To configure the Allworx IP phone:

Configure an Allworx IP phone Programmable Function Key (PFK) as a Queue Appearance. See
"Manage the Programmable Function Keys (PFKs)” on page 68 for more information. The PFK monitors
the status of a queue and answer calls in the queue.
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7.5 Manage Call Supervision

The supervisor presses the Call Supervision PFK, enters an agent extension, and begins supervising the
call. If the supervisor has a BLF PFK for the agent, press the Call Supervision PFK followed by the BLF
PFK to initiate the session. There is no indication to the agent that supervision is in progress.

Call supervision is available via a PFK configured on the supervisor's Allworx phone. See "Manage the
Programmable Function Keys (PFKs)” on page 68 to configure the handset. Enable the agent phone for
supervision by modifying the agent Call Supervision setting of the Handset Preference Group.

7.6 Manage Calls to Route to a Call Queue

Calls enter a queue when routed by an extension. Select a queue for the final call route of an extension
(refer to this extension as the "queue extension”). Route the incoming calls to the queue extension:

. route outside lines directly to the queue extension, see "Manage Call Routes” on page 58.

. configure an Auto Attendant with a shortcut to the queue extension and route incoming calls to
the Auto Attendant, see Menu Shortcuts in "Auto Attendant Configuration Settings” on
page 18.

7.7 Route a Call using Auto Attendant to a Call Queue

Inbound calls come into an Auto Attendant. If configured, the Auto Attendant plays a custom greeting.
Example: “For Customer Support, press 2.” After pressing 2, the caller hears the queue greeting, and
the system places the call into the queue.

To configure the Call Routing to an Auto Attendant, and then to a Call Queue:
1. Define the call route of the outside line to direct calls to the Auto Attendant. See "Manage Call
Routes” on page 58 for more information.

2. Create a Customer Support extension. Define the call route to immediately transfer calls to the
Customer Support queue. See "Add New Extension” on page 55 for more information.

3. Record an Auto Attendant custom greeting instructing the caller to press 2 to reach Customer
Support. See "Record Auto Attendant Greetings and Messages” on page 20 for more
information.

4. Configure the Auto Attendant menu shortcut for digit 2 to transfer calls to the Customer
Support system extension. See "Auto Attendant Configuration Settings” on page 18 for more
information.
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7.8 Display Queue Statistics

Allworx ACD Queuing offers a rich variety of statistics to monitor, track, and analyze queue activity. The
statistics are available in three ways:

. view via My Allworx Manager.
. export to XLS file from My Allworx Manager.
. stream to an external device connected to server.

7.8.1 Display Queue Statistics Report

All users can see the agents of the logged in queues. The statistics are available for queues determined
by if the queue is a Ring All queue or an ACD queue. See the Allworx Server User Guide for report
information.

7.8.2 Display Live Calls

To display the live calls from the queue, see “Live Calls” on page 201 for more information.

7.9 Record Queue Greetings and Messages

Call queues play built-in or site-specific greetings and messages. Users with Recording Manager
permissions can record the greetings Offline, and then import the greetings into the system (see
"Import Greetings and Messages” on page 34 for more information) or record up to nine (9) greetings
and one (1) custom message for each Call Queue using the phone through the Message Center.

To enable Recording Manager permissions, see "To modify or delete existing users:” on page 133 and
update the Recording Manager setting. Select the specific Call Queue for the user.

To record a new queue greeting and status message:

Note: Allworx does not recommend using a Reach handset to record new greetings or queue messages as the ability of the
: server to record greetings is intolerant of network packet loss. As a result, recordings made via lossy networks may
have impaired quality. Local or wired networks are best for making recordings.

Note: For systems with Dual Language Support: Users cannot change languages within the Message Center. To record new
: messages in a second language, select an option:

« Setup an account configured for the secondary language, and then record the greetings using that account.

« Temporarily modify the user’s default language to match the secondary language of the system.

1. Dial the Message Center extension, 404" from the phone.
2. Log in using the assigned Allworx PIN followed by the # sign.
If configuring the system for Dual Language Support, the system associates the new greetings

and messages with the current language. To record greetings for an alternate language, switch
languages before proceeding to the next step.

1. Extensions may vary per system. If you are using a non-default Internal Dial Plan, consult the Phone Features tab
of the My Allworx Manager page to determine what extensions to use for the corresponding feature.
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3. Dial 9 to manage recordings, and then dial 2 to manage Call Queue.

4. Enter the number of the Call Queue to manage (0 through 9).

5. Dial 1 for the greeting or 2 for the status message.
Dial Greeting Dial Greeting
1 Manage Call Queue greeting # Return to the Auto Attendant
2 Manage Call Queue status message * Replay the options

6. Dial 2 to start recording. Begin speaking after the beep.

7. Dial # to stop recording and select from the following options:
Dial Greeting Dial Greeting
1 Save the greeting # Cancel the changes
2 Change the greeting * Replay the options
3 Review the greeting
8. Hang up to end the session.

7.10 Import Greetings and Messages

Import the greetings and messages recorded Offline onto the Allworx system. The files use a specific
internal format and have a specific file name format - Example: cq#x.snd. The filename for the status
message for Call Queue 3 is “cq3s.snd”.

Format Digit Description
# Replace with a Call Queue number 0 through 9.
X Replace with “g"” for greeting or “s” for status message.

See "Custom Recordings” on page 215 for more information.

Click here to return to the Install Checklist .
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Chapter 8 Conference Center

Conference Center enables users to reserve T
conference bridges using My Allworx Manager Prerequisites
while enforcing password restricted access to the
conference for attendees.

Access Permissions Allworx Server Administrator
Allworx System Administrator
Phone Administrator role

The Conference Center terminates the call ff the
conference call extends beyond the scheduled Feature Key Required Conference Center
end time unless there are other scheduled
conference calls.

Server Type Termination

Allworx 6x, 6x12, Connect A scheduled or unscheduled conference currently in use automatically terminates when another scheduled
300 and 500 series conference begins.

Servers » An unscheduled conference does not terminate conferences in session.

 Supports one active conference at a time.

Allworx 48x, Connect 731 When using all conference bridges and a new conference is scheduled to begin, the server terminates the
Servers unscheduled conference with the oldest start time first.
« If none of the unscheduled conferences are in use (i.e., all in-use conferences are scheduled conferences),
the server terminates the conference farthest past the scheduled duration.
« Initiation of an unscheduled conference does not terminate conferences in session.

To manage the conference calls:
1. Log in to the Allworx server admin page, navigate to Phone System > Conference Center. The
server displays a list of scheduled conferences.

2. Locate the conference and click one of the following links:
end conference Terminates the in-process conference call.
modify Change the description, password, and moderator. Click Update to save the changes or Cancel to

disregard the request.

Enabled / Disabled Check or uncheck the box to activate or deactivate the specified conference, respectively.

Delete Removes the conference call from the schedule. Click Delete to save changes or Cancel to disregard
the request.

Click here to return to the Install Checklist .
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Chapter 9 Dial Plan

Dial Plan manages the internal extension length

and the Emergency Number Dialing. Prerequisites
Additionally, Allworx administrators can
customize the digits for users to dial to access to ~ Access Permissions i SEEr AdmisiEies
Allworx System Administrator
the Allworx server features. Phone Administrator role
Feature Key Required No
[ ]
9.1 Setup Checklist
Follow the order of the steps to successfully setup the Dial Plan.
Step Description Installation Guide Link
1 Set up the Internal Extension Length before defining users, “"Manage the Internal Extension Length” on page 37
handsets, or extensions.
2 Set up the Internal Dial Plan. "To manage the Internal Dial Plan:" on page 39
Set up the Service Groups. “Manage DID Routing Configuration” on page 40
4 Set up the External Dialing Rules (including "Manage External Dialing Rules” on page 42
Emergency Number Dialing).
5 Set up the Dialing Privileges Groups. “Manage Dialing Privileges Groups” on page 46

9.2 Manage the Internal Extension Length

Note: This feature is compatible with Reach 2.0.7 (minimum) and Interact 2.3 (minimum)

Define users, handsets, or extensions, and then increase the internal extension length.

Note:

Internal extension lengths cannot be decreased AFTER increasing extension length. It is highly recommended that
Allworx administrators perform an OfficeSafe Backup before increasing the extension length.Once the system
extension length has increased, Allworx administrators can only decrease the extension length by using an OfficeSafe
Restore, which resets the Allworx server to the backed-up configuration.

Caution:

Configure the handset extensions from three (default) up to six digits. All existing extensions expand to
the new length. After increasing the internal extension length to 5 or 6 digits, the extensions show
available link is no longer available on the following web admin pages:

. Phone System > Users > add new user

. Phone System > Users > Modify

. Phone System > Extensions > add new extension
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In addition to the changes in user and system extensions, the following server configurations
automatically update when changing the internal extension length:

 Extension call routes including Internal Caller-ID checking  Speed Dial PFK (differs from Personal Speed Dial PFK)

« System Speed Dials (the Speed Dial extension doesn't change « Default Extensions, extensions accessed by Shortcuts, and “Dial
but the dialed extension changes) By Directory” listings of Auto Attendants

- DID mappings - Off hook digits dialed for handsets

+ Incoming outside line call routes Call Detail Records (prior records are unaffected by the change)

Extension Length changes do not affect the following server configurations’:

+ System Speed Dial extensions (350-399, 34000-34999) » Conference Center (408)

« Call Park extension and Parking Orbits (700-709)  Paging extensions (460-469)

« Auto-Attendant extensions (400, 4301-43xx*) * Queue extensions (4400-4409, 4410-4419)
« Door Relay (403) » Modifying Internal Dial Plan

* Message Center (404) * Personal Speed Dials

(users must modify since the phone stores the numbers)

* Where xx is the maximum number of Auto Attendants supported by the Allworx server.

To change the extension length:

Note: Servers that are part of multi-site networks cannot change the Extension Length.
Note: Existing extensions change after modifying the system extension length.
Caution: Internal extension lengths cannot be decreased AFTER increasing extension length. It is highly recommended that
° Allworx administrators perform an OfficeSafe Backup before increasing the extension length.Once the system
extension length has increased, Allworx administrators can only decrease the extension length by using an OfficeSafe
Restore, which resets the Allworx server to the backed-up configuration.

1. Log in to the Allworx server admin page. Navigate to Phone System > Dial Plan.
2. Locate the Internal Extension Length section, and click modify.

3. Select the number of digits to use for the extensions in the drop-down list.

4. Click Update to save the changes or Cancel to disregard the changes.

5. Update other dial plan changes, as needed, and then click Reboot Phones to update the
handsets to the new configuration.

1. Extensions may vary per system. When using a non-default Internal Dial Plan, consult the My Allworx Manager
Phone Features tab to determine what extensions to use for the corresponding feature.
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9.3 Manage Internal Dial Plan

The Internal Dial Plan specifies the first digit for user extensions and other PBX functions such as
forwarding calls and accessing outside lines. There are two configuration modes for the Internal Dial

Plan:
Normal Mode User and system extensions are a continuous range of extensions numbers. The numeric range varies between
1xx and 9xx. Example: three-digit extensions between 100 and 299 or between 700 and 899.
System functions (Speed Dials and retrieving parked calls) are in other ranges not assigned to user extensions.
Extension Mode User and system extensions can be in any numeric range. The server reserves only the operator digit (e.g.,0) and

the PBX external dial digit (e.g., 9). System functions begin with an asterisk (*). Example: extensions can range
between 100 and 899 or 1000 and 8999.

To manage the Internal Dial Plan:

1. Log in to the Allworx server admin page. Navigate to Phone System > Dial Plan.
2. Locate the Internal Dial Plan section, and click one of the following options:
modify Change the internal dial plan settings.

» Default: Normal mode

» Extension Mode: click the checkbox.

NOTE: If the system is part of a Multi-site network, the Allworx administrator cannot change the Internal Dial
Plan between Normal Mode and Extension Mode.

view Opens the My Allworx Manager log in page. Enter the user Username and Password, and then click Login.
The Phone Functions Reference Card page displays in a new browser window.
3. Select the leading digit from the drop-down list in the first column. The table displays examples

of the dialing plan during the selection process

4. Click Update to save the changes or Cancel to disregard the changes.The Dial Plan page
displays. Locate the top message about rebooting Allworx phones and click Reboot Phones to
update the handsets to the new configuration.

Internal Dial Plan Settings

User and System
Extensions

Identifies the first number used for phone extensions.

Operator

Identifies the number for callers to dial to contact the internal operator.

External Call access

Identifies the number to dial first to gain access to an outside line. Follows the External Dialing Rules.

Enterprise calling

Enables a third party SIP server to be the central hub for calls between multiple sites that have Allworx
servers. This provides a centralized phone book and administrative service for the entire VoIP network.

Internal station access

Reserved for system

Speed dial numbers

Identifies the number to indicate a speed dial number follows.

Message Center

Short-cut access to the Message Center to:

+ manage presence and presence greetings

* name recording

* PIN

« access and listen to voicemail messages (even from another Allworx phone).
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Call Functions Identifies the initial number to dial to access various call functions (park/pickup/audit pin code).

Leave a voicemail for Identifies the initial number to dial to access a voicemail box to leave a message for another user.
extension

PBX Functions Identifies the initial number to dial to access various PBX functions - door relay, Conference Center, do not

disturb, Auto Attendants, Call Queues, call retrieve, call forwarding, or paging.

9.4 Manage DID Routing Configuration

Enables Allworx administrators to disable or enable the DID-to-extension mapping feature. If disabled,
the internally dialed DID numbers route via the external dialing rules.

To manage the Internal Dial Plan:

1. Log in to the Allworx server admin page. Navigate to Phone System > Dial Plan.
2. Locate the DID Routing Configuration section.

3. Select an option from the drop-down list.

4. Click Update to save the changes or Cancel to disregard the changes.

9.5 Manage Service Groups

A Service Group is a collection of services use for placing outside calls. The Allworx server uses a
variety of services to place outside calls; some of these services are optimum for particular types of
calls. Example: the SIP Proxy might be the least expensive way to make long distance calls, but the CO
lines are best for local calls. The server creates several Service Groups automatically:

. All Digital Lines . All Digital Lines, CO Lines & SIP Gateways
. All SIP Proxies . No Devices (use to prevent placing external calls)
. All Trunk Devices . All Digital Lines & CO Lines

. All SIP Gateways

The Allworx administrator can define additional Service Groups to control the use of services or set of
services for certain dialed calls.

When initiating an outbound call using the Service Group, the server tries services in the group in
top-down order until an idle service is found. The call made uses the first idle service in the list.
Therefore, the last step in setting up a Service Group ensures that the order of the services reflects the
preferred use priority. When one of the services in the group is a SIP proxy, the server considers the SIP
proxy idle until reaching the Maximum Active Calls setting.

To manage the service group:
1. Log in to the Allworx server admin page, navigate to Phone System > Dial Plan.
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2. Locate the Service Groups section and click one of the following links:

add new Create an additional Service Group.
Service Group 1. Enter a Description for the new group.
2. Move the preferred services into the Service Group box.
3. (optional) User the Move Up or Move Down buttons to change the Services order.
4. Click Add to save the changes or Cancel to disregard the changes, and reboot the phones to update the
handsets to the new configuration. Requires no further action.

Copy Create a new dialing privileges group with the same settings as the copied group.

Modify Change the settings configuration.

. Enter a Description for the new group.

. Move the preferred services into the Service Group box.

(optional) User the Move Up or Move Down buttons to change the Services order.

. Click Update to save the changes or Cancel to disregard the changes, and reboot the phones to update
the handsets to the new configuration. Requires no further action.

Delete Remove the current Service group from the server (the Allworx administrator cannot delete the default
group). Confirm the decision and click Delete to remove the Service Group from the server or Cancel to
disregard the request. Requires no further action.

9.5.1 Configure Remote Sites as Services

Remote sites should not be the only method available to place external calls. Loss of Internet connectivity between
the local site and the remote site (at either end) may disable the ability to place calls including 911 Emergency calls.

Note:

Select remote sites as services for handling outbound calls. If the line selection process results in a
routing call to a remote site, the call connects using one of the remote sites’ outside lines. The dialing
rules configured on the remote site determines which lines to use and how to dial the number (with or
without area code).

The Allworx server automatically prevents configuring the dial plans on multiple sites accidentally to
avoid routing a call back and forth among the sites. If a call comes to a server from a remote site, the
receiving server does not forward the call to the same or other remote sites. If the dialing rule that the
call is using on the receiving site includes any remote sites, the system skips the remote sites and uses
another outside line service.

9.5.2 Configure Service Groups / Handset Outside Line Restrictions

Service Groups direct outbound calls to specific services. The server selects the first idle service in the
group. The handset configuration supports restricting the use of lines further when placing an outside
call. The server uses the number dialed to locate the configured Service Group for the outbound call.

After finding the first idle service in the group, the Outside Line Selection Method in the handset Call
Appearance Dialing Privileges Group is checked. If the idle service is restricted for the handset, it finds
the next idle service and requires the handset to check again. This continues until the system finds a
non-restricted idle service to place the call. If the server cannot find a non-restricted idle service, the
caller hears a fast busy signal to indicate there are no available outside lines.

1-866-ALLWORX * 585-421-3850 Page 41
www.allworx.com
Revised: 12/21/2016



Section 3 - Phone System e allworx.
9.6 Manage External Dialing Rules

The external dialing rules indicate to the Allworx server what digit sequences are valid for dialing out
on the public phone network. As a user dials digits on an Allworx phone, the server collects the digits,
one at a time to place the call. Use the dialing Rules and Service Groups for Call Appearance, not for
Line Appearance calls because the Line Appearance accesses outside lines directly.

Enhanced external dialing rules supports matching specific dialing sequences and then deleting,
inserting, and/or appending digit strings to those numbers before sending the dial string to any SIP
Gateway, SIP proxy, T1/PRI Digital Line, or CO line. This flexible dialing supports programming the
dialing behavior of the Allworx server to match specific business needs. Examples:

Number Description

Local number Users dial a 7-digit number (normally not 1 + <area code>). The server collects the 7-digits dialed, and then
attempts to make the call. The server is not waiting for more digits.

Long distance Users normally dial 1 + <area code> + 7-digit local number. The server recognizes this case distinctly from
the local number case, and collects all 11 digits before attempting to make the call.

Some local calling areas  Require dialing a <area code> + 7-digit number (without the 1 prefix) to properly dial some numbers. This
implies that these rules may vary depending on the local calling area with an installed Allworx server.

The server dialing rules automatically detects when an outbound dialed number is associated with an
internal extension (local or multi-site). When detecting this case, the system places the call to the
internal extension. The system considers 10-digit DIDs for matching and attempts to match all 10-digit
dialed calls as well as all 7-digit dialed calls, if the server home area code is set. If there are overlapping
DID blocks on a local server, the server uses the first matching DID. In a multi-site network, the local
server uses the DIDs for the local site first followed by the DIDs at the remote sites.

Example: DID 789-456-0123 maps to extension 101 (external call access number is 9 in this example)

Home Area Code

User Dials set to 789 Call Placed to
9-1-789-456-0123 N/A Extension 101.
9-456-0123 Yes Extension 101.
9-456-0123 No Phone number: 456-0123.

9.6.1 Manage the North American Numbering Plan Administration
(NANPA)

The Allworx server routes calls using the Service Group assigned to the type of number dialed. When
enabling or disabling NANPA, it changes the types of numbers dialed that the system supports.

To manage the NANPA settings:

1. Log in to the Allworx server admin page. Navigate to Phone System > Dial Plan > External
Dialing Rules.

2. Locate the North American Number Plan section, and click modify.
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3.

Check the box to enable NANPA for installations in North America, and disable NANPA for all
other locations. When disabling NANPA (unchecked) access the outside lines using the steps
described in the Exceptions section, above. Click Update to save the changes or Cancel to
disregard the request.

When enabling NANPA, the Allworx administrator cannot add, modify, or delete the default
rules. The rules affected by enabling NANPA are service rules, operator rules, emergency rules,
and 11-digit dialing rules. Exception: the Allworx administrator can add to the 11-digit dialing
rules, if the total digits is equal to 11.To add, modify, or delete the rules, the Allworx
administrator must disable NANPA.

NANPA Enabled Requirements

Rule Leading Digits Total Digits Auto Delete Existing
Service Rule 211 3 Yes
Service Rule 311 3 Yes
Service Rule 411 3 Yes
Service Rule 511 3 Yes
Service Rule 611 3 Yes
Service Rule 711 3 Yes
Service Rule 811 3 Yes
Operator Rule Operator 1 Yes
Emergency Rule Emergency Any Yes
Rules beginning with 1 1 [any other digits] Not equal to 11 Yes

9.6.2 Manage the Home Area Code Requirements

Some features of the Allworx server and phones (example: redialing from call history and when
mapping numbers to 11-digit forms to SIP proxies) require knowledge of the home area code. This
required information is part of the dialing rules to support those features to operate properly.

To manage the home area code:

1. Log in to the Allworx server admin page.

2. Navigate to Phone System > Dial Plan > External Dialing Rules > Home Area Code >
Modify.

3. Enter the area code in the field provided.

4. Click Update to save the change or Cancel to disregard the request.
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9.6.3 Select the Automatic Route

The dial method controls whether or not to include the area code when the placing the call. If the area
code is not properly configured for the local rules, the system may not correctly place local calls.
Configure the area codes to use the correct service for the local and other area codes and to use the
correct number of digits when placing the call.

To select the automatic route:

1. Log in to the Allworx server admin page, navigate to Phone System > Dial Plan.
2. Locate the External Dialing Rules > Automatic Route Selection section.
3. Click one of the following links:
- Bulk Edit Delete the checked route definitions.
add new rule Activate another rule. See "Automatic Route Selection Rule Settings” on page 44 for more settings

information. Click Add to save the new rule or Cancel to disregard the request.

Modify Change the selected rule. See "Automatic Route Selection Rule Settings” on page 44 for more
settings information. Click Update to save the changes or Cancel to disregard the request.

4. Locate the message about rebooting Allworx phones and click Reboot Phones to update the
handsets to the new configuration.

Automatic Route Selection Rule Settings

Setting Description

Leading Digits User dialed digits. For areas that require dialing the area code or other type exchange, this is the aaa (area
code). For areas that require dialing 1 + area code (or other exchange), this is 1aaa (aaa is the area code/
exchange).

Total Digits Number of digits (1 to 24) including digits 0-9 dialed by the user for the pattern.

Delete Leading Digits Number of the first 0 to 24 caller-dialed digits deleted from beginning of the dial string before sending the

request to a service group.

Insert Leading Digits Digits not dialed by the user. Inserted at the beginning of the dial string after deleting leading digits before
the string passes to the remote device. It is possible to insert 0 to 24 digits (0-9), #, *, or pauses (P).

Append Trailing Digits Digits added to the end of the dial string - 0 to 24 digits (0-9), #, *, or pauses (P).

Service Group Select an option from the drop-down list:
+ All CO Lines
+ All CO Lines & SIP Gateways
» All SIP Gateways
« All SIP Proxies
« All Trunk Devices
« Including any added service groups
* No Devices

Example 1:
Adding an area code with “Area code NOT dialed”. In this case, the user dials 1234567, the area code is
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585, and the output dial string is 15851234567.

Setting Description Setting Description
Leading Digits 0 Insert Leading Digits laaa
Total Digits 7 Append Trailing Digits 0
Delete Leading Digits 0

Example 2:
Adding an area code with “Area code dialed”. In this case, the user dials 5851234567, and the output

dial string is 15851234567.

Setting Description Setting Description
Leading Digits aaa Insert Leading Digits laaa
Total Digits 10 Append Trailing Digits 0
Delete Leading Digits 0

Example 3:
Adding an area code with “1 + area code dialed”. The user dials 15851234567, and the output dial

string is 15851234567.

Setting Description Setting Description
Leading Digits laaa Insert Leading Digits 0

Total Digits 11 Append Trailing Digits 0

Delete Leading Digits 0

9.6.4 Manage the Emergency Number Rules

Note: Do not enter an Emergency number that conflicts with other dial plan options as this may result in the emergency
: center not being called.

Note: Reboot Allworx phones when making changes to the Emergency values.
. Do not attempt to place emergency (911) calls prior to activating the Connect server.

Caution: priop gency O11) calls p 9

Important: Prior to configuring the emergency dial plan, the emergency number rule defaults are:

Not Set Emergency Number: 911
Direct Dial: enabled (checked)

Set Uses the Emergency Number and Direct Dial settings as previously set by the administrator.

To configure emergency number rules:
1. Log in to the Allworx server admin page, navigate to Phone System > Dial Plan.

1-866-ALLWORX * 585-421-3850 Page 45
www.allworx.com
Revised: 12/21/2016




Section 3 - Phone System e allworx.

2. Locate the External Dialing Rules > Emergency section, and click Modify.

3. Update the fields:

Emergency Enter the number to dial for emergency situations.

Dial Direct Enables users to dial the emergency number without the line access number. Check the box to enable.

4. Click Update to save the changes or Cancel to disregard the changes.The Dial Plan page
displays.

5. (optional) Locate the Emergency Call Email Notification line and click modify. Check box to
enable email notifications of emergency calls, and then click Update to save the change or
Cancel to disregard the request.

6. Locate the top message about rebooting Allworx phones and click Reboot Phones to update
the handsets to the new configuration.

9.6.5 Manage the Services

To manage the services:
1. Log in to the Allworx server admin page, navigate to Phone System > Dial Plan.

2. Locate the External Dialing Rules section, and then the Services table. Click Modify.

3. Select the Service Group affected in the drop-down list. For the Public SIP Director and PIN
Code feature, specify the number of digits.

Note: To change the PIN code length, the system cannot have any previously configured PIN codes.
4. Click Update to save the changes or Cancel to disregard the request.
5. Locate the message about rebooting Allworx phones and click Reboot Phones to update the

handsets to the new configuration.

9.7 Manage Dialing Privileges Groups

A Dialing Privileges Group is a set of dialing permissions and handset Call Appearances with the same
settings. Apply custom configurations to any or all of the site handsets by creating a Dialing Privileges
Group, specifying the settings, and assigning handset Call Appearances to the group. Changes made

to the group settings take effect immediately. Handset Call Appearance dialing permissions determine
how to access outside lines, determine which outside lines to use, and enable or block phone numbers.

To manage the dialing privileges groups:
1. Log in to the Allworx server admin page, navigate to Phone System > Dial Plan.
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2. Locate the Dialing Privileges Groups section, and then click one of the following links:
View View and modify the current dialing permissions group.
Copy Create a new dialing privileges group.
Delete Remove the current dialing privileges group from the server. However, the Allworx administrator

cannot delete the default group or groups with assigned handsets. Therefore, move all handsets
into other groups to delete the group.

3. Locate the section to update and click Modify:

Section Description

Dialing Privileges Group

When upgrading Allworx servers, create an additional Dialing Privileges Group for each unique combination of Outside Line
Connection settings for the existing phones.

NOTE: The system does not change settings for existing handsets in this process.

Dialing Privileges Group settings include the following:

» Emergency Service Group

 Schedule

« Toll Restrictions

+ Outside Line Selection Method

Name Enter a new name in the field

Emergency Service Select a group from the drop-down list.

Group

Schedule Associate a schedule with each Dialing Privileges Group to specify different Toll and Internal

Call Restrictions for the Dialing Privileges Group based on the schedule. This option supports
additional flexibility by limiting which numbers specific handsets can dial at various times of
the day. Example:

« Don't let the lobby phone dial the door relay or paging zones.

» Don't let certain employees dial the CEOQ.

« Don't let any phone make long distance calls after business hours.

Select a schedule option from the drop-down list, and then use the option drop-down lists to
further refine the call restriction type. See the Toll Restriction and Internal Call Restriction
sections below for the restriction options.

Schedule Option Restriction Type Available

Not Used » Toll Restriction
« Internal Call Restriction

<Available Schedule> » Day Mode Toll Restriction
» Night Mode Toll Restriction
« Day Mode Internal Call Restriction
» Night Mode Toll Restriction

Seize Rule Select a rule from the drop-down list.
Outside Line Selection Select one of the options:
Method  Use External Dialing Rules for number dialed

« User External Dialing Rules, but restrict to these services: check the appropriate check boxes.
Shortcut: click check all or uncheck all.

« Ignore External Dialing Rules and always use this service or Service Group: select an option
from the drop-down list.
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Section Description

Toll Restriction
Define toll restrictions between different Dialing Privileges Groups.When programming a specific Dialing Privileges Group, the
Allworx administrator selects which Toll Restrictions to apply to the Dialing Privileges Group.

The server enables all numbers defined by the External Dialing Rules unless listed in the Blocked Numbers list.

« Numbers in the Exceptions list override the blocked numbers.If listing a number as both blocked and as an exception, the
server enables calls to that number.

« Entries in the Blocked Numbers list need not be complete phone numbers but can be only the first part of phone numbers.
The numbers entered are a pattern, which the Allworx server reads left to right. Once the pattern has been matched (see
example) the number is blocked. Example: entering 1900 in the Blocked Numbers list prevents all 1-900 number calls.

Entries in the Exceptions list should be more specific than those in the Blocked Numbers list.

« The Exceptions to the Blocked Numbers list does not need to have any entries to specify enabling similar numbers.

« If the Blocked Numbers list contains 1 as an entry and the Exceptions to Blocked Numbers list contains 1800, then users can
dial 1-800 numbers but no other long distance number.

« If the Blocked Number list contains a complete number (e.g. 19005553850) then the server blocks only that number.

NOTE: When attempting to block the emergency number, the Allworx System Software requires a confirmation prior to
accepting the request.

Add Create a new rule.
Enter new name Describe the new rule.
Blocked Numbers Enter the blocked numbers in the fields provided.
Exceptions to Enter the exception numbers in the fields provided.

Blocked Numbers

Click Add to save the change or Cancel to disregard the request.

Modify Update the rule.
Update the name Describe the rule.
Note: The Toll Restrictions (Default) name cannot be changed.
Blocked Numbers Enter the blocked numbers in the fields provided.
Exceptions to Enter the exception numbers in the fields provided.

Blocked Numbers

Click Update to save the change or Cancel to disregard the request.

Delete Remove the rule from the list. Verify this is the rule to delete, and then click Delete to remove
the rule or Cancel to disregard the request.

Note: Toll Restrictions (Default) cannot be deleted.

Internal Call Restrictions
Block internal calls (extensions, PBX functions, etc.) When programming a specific Dialing Privileges Group, the Allworx
administrator selects which Internal Call Restrictions that apply to the Dialing Privileges Group.

The server enables all numbers unless listed in the Blocked Numbers list.

* Numbers in the Exceptions list override the blocked numbers.

« If listing a number as both blocked and as an exception, the server enables calls to that number.

« Entries in the Blocked Numbers list need not be complete phone numbers but can be only the first part of phone numbers.
Example: entering 12 in the Blocked Numbers list prevents calling internal extensions 1200 to 1299 or entering *4 in the
Blocked Numbers list prevents calling all PBX functions.

Entries in the Exceptions list should be more specific than those in the Blocked Numbers list.

+ The Exceptions to the Blocked Numbers list does not need to have any entries to specify enabling similar numbers.
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Section Description
Add Create a new rule.
Enter new name Describe the new rule.
Blocked Numbers Enter the blocked numbers in the fields provided.
Exceptions to Enter the exception numbers in the fields provided.
Blocked Numbers
Click Add to save the change or Cancel to disregard the request.
Modify Update the rule.
Enter new name Describe the new rule.
Note: The Internal Call Restrictions (Default) name cannot be
changed.
Blocked Numbers Enter the blocked numbers in the fields provided.
Exceptions to Enter the exception numbers in the fields provided.
Blocked Numbers
Click Update to save the change or Cancel to disregard the request.
Delete Remove the rule from the list. Verify this is the rule to delete, and then click Delete to remove

the rule or Cancel to disregard the request.

Note: Internal Call Restrictions (Default) cannot be deleted.

Call Appearances Assigned to Group

Check the box next to a Call Appearance to include it in the group. When removing a Call Appearance from a user-defined
group, it moves automatically to the default Group.

4. Click Update to save the changes or Cancel to disregard the request, and then reboot the
phones to update the configurations.

Click here to return to the Install Checklist .
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Chapter 10 Emergency Alerts and Caller ID

The 911 Alert sends audible and visual alerts to -
designated handsets immediately after making Prerequisites
an emergency call from any local or remote

handset and supports email and SMS message

Access Permissions Allworx Server Administrator
Allworx System Administrator

supersedes any handset functionality, except
when the handset user is in an admin menu. Feature Key Required No

. Do not attempt to place emergency (911) calls prior to activating the Connect server.
Caution: priop gency (911) calls p 9

Important: Prior to configuring the emergency dial plan, the emergency number rule defaults are:

Default Description
Not Set Emergency Number: 911
Direct Dial: enabled (checked)
Set Uses Emergency Number and Direct Dial settings as previously set by the administrator.
. To dial the emergency number without dialing the external line access digit, see "Manage the

Emergency Number Rules” on page 45 for more information.

. To configure handsets to receive 911 alerts, assign an Emergency Alert PFK. See "Manage the
Programmable Function Keys (PFKs)” on page 68 for more information.

10.1 Emergency Alerts

When any handset places an emergency call on the system, handsets with the emergency alert PFK
produce an audible beeping and displays the information:

. owner of the handset which placed the call.

. station number of the handset the call originated from.

. date / time of the call.

Status Pressing the PFK

Active Alert Acknowledges the alert, silences the beep, and removes the alert information from the display screen.
Inactive Alert Retrieves information of the last alert stored on the handset.

Rebooting the handset Removes stored alert details from the handset.

The Allworx server automatically acknowledges active alerts by silencing all handsets beeping after 10
minutes and removing the handset display alert information after 60 minutes.
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Additional emergency calls placed from other handsets within 15 seconds results in the server
disregarding the new alerts, and the handset stores the emergency call placed after the 15 second
time period after the user acknowledges the first alert. Press the PFK or CLEAR soft key to acknowledge
the alert.

Emergency alerts supersede any handset functionality (e.g. placing/receiving a call, logged into
message center), except when the user of the handset is in an admin menu (e.g. viewing directory,
CONFIG menu settings, changing presence setting). In this case, the PFK blinks. Once the user exits the
menu screens, the handset repeats the alert audible beeping and information.

Note: Calls do not disconnect when an Emergency alert is propagated to the handset.

10.2 Manage Emergency Handset Caller ID

The Allworx server supports assigning an Emergency Caller ID (CID) number to each Allworx handset.
When dialing an emergency number from the handset, the Emergency CID passes to the emergency
call center instead of the normal CID. For employees not at the main site, the properly configured
Emergency CID helps the emergency call center locate the handset placing the call.

Setting Emergency Caller IDs to place emergency calls on a CO line do not work. The Emergency CID does not

Caution: override the Caller ID of the CO line.

If using SIP trunks or PRI lines, check with the provider to determine the Caller ID numbers to use, if any, or to
configure additional phone numbers as caller IDs for emergency calls. After setting up Emergency Caller ID numbers
on the Allworx server, call the emergency phone number (e.g., 911) to test each number. Use a phone configured with
the caller ID to ensure that the emergency calls connect, route to the correct emergency call center, and the call
center can independently determine the handset location. Advise the call center that these test calls are non-
emergency calls to test the phone system.

Caution:

To configure Emergency Caller IDs for specific handsets:
. define an Emergency Caller ID and assign it to the handsets.

. give each Emergency CID a Location name and associate each with a Service Group to use when
placing an emergency call. When selecting the Use External Dialing Rules service group, the
server selects the outside line or service group with the area code of the Emergency CID
number.

To manage the Emergency Caller ID numbers:
1. Log in to the Allworx server admin page, navigate to Phone System > Emergency CID, and
locate the Emergency Caller ID Numbers section.

2. Click one of the following links:
add new Caller ID Create another emergency caller ID number.
Number 1. Enter the Caller ID number and Location. Use a descriptive handset name for the locations that

use this caller ID.
2. Select a service group from the drop-down list.
3. Click Add to save the changes or Cancel to disregard the request.
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modify Update the Location and Service Group fields.
1. Enter the new Location.
2. Select a service group from the drop-down list.
3. Click Update to save the changes or Cancel to disregard the request.

Delete Removes the Caller ID number from the list. However, administrators cannot delete Emergency
CIDs with assigned handsets. Assign all handsets to another Emergency CID prior to deletion.
Confirm the number and click OK to save the changes or Cancel to disregard the request.

10.3 Assign the Emergency Caller IDs

Assigned Emergency Caller IDs via the phone admin page or its CONFIG menu overrides the CID number for the
handset, if assigned on the server.

Note:

To assign using the server administration page:

1. Log in to the Allworx server admin page, and navigate to Phone System > Emergency CID. The
page displays all handsets on the system in the table under the Handset Emergency Caller ID
Number Assignments section.

2. Locate the Handset Emergency Caller ID Number Assignments table, and then locate the
handset.

3. Click Modify, and then select a Caller ID number from the drop-down list.

4. Click Update. If using the handset option, the system requires a phone reboot to display the
changes on the server admin page.

When assigning an Emergency CID number to a handset from the Allworx server admin page, the Caller ID number

Note: does not display on the phone admin page or under the CONFIG menu.

Click here to return to the Install Checklist .
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Chapter 11 Extensions

Extensions manage extensions or call routes -
this includes special purpose call routing to these
extensions. Additionally Extensions provide a
short cut to manage users.

Prerequisites

Access Permissions Allworx Server Administrator
Allworx System Administrator
Phone Administrator role

11.1 Add New Extension Feature Key Required No

Enables adding an extension to the Allworx
system directory.

To add a new extension to the directory:

Note: After increasing the internal extension length to 5 or 6 digits, the extensions show available link is no longer
: available.
1. Log in to the Allworx server admin page, and navigate to Phone System > Extensions > add

new Extension and update the fields.

System Extension Enter a requested extension number or click show available and click on an available number
to select the extension. Click hide available to close the list of available numbers.
Description Enter a name for the extension, i.e., Conference Room.
Schedule Select a schedule for the extension to use for business hours from the drop-down list.
2. Locate the Call Route section, and click add a connection attempt. This enables forwarding the

call to another number.

3. Locate {no selection}, the number of rings, and the Ring Type sections and select an option for
each from the drop-down list. (Number of rings and Ring Type style are optional).

Ring Types

Phones can be set to ring with different patterns and tones to:

Differentiate between incoming internal calls and incoming external calls.
Identify calls from a specific caller ID.

Differentiate between the lines for the incoming call (including calls on certain Call
Appearances, Line Appearances, or ACD queues).

Help multiple users in a shared space identify which phone is ringing.

The Allworx system provides eight Ring Type Families with eight Ring Types within each family.
The Allworx Server Administrator chooses the Ring Type used on the phones in the extension
and programmable button definitions. Verge IP phone users can choose the family from which
the selected Ring Types. The appearance programmable button Ring Type setting overrides any
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call route specific Ring Type choices unless the appearance programmable button Ring Type is

set to Auto.

The table below defines the available Ring Types.

Analog Handset

Allworx Handsets
Families 1 -4

Allworx Handsets
Family 5

Single Ring Single Single Ring Pitch A Single Ring Pitch E

Double Ring  Double Ring [short, short] Double Ring Pitch A Double Ring Pitch F

Ring Type 1 Double Ring [short, long] Single Ring Pitch B Triple Ring [short, long, short] Pitch G

Ring Type 2 Double Ring [long, short] Double Ring Pitch B Quad Ring [long, long, short, short] Pitch H
Ring Type 3 Triple Ring [long, long, long] Single Ring Pitch Tone C Triple ring [long, long, long] Pitch |

Ring Type 4  Triple Ring [short, short, long] Double Ring Pitch Tone C Triple Ring [short, short, long] Pitch J

Ring Type 5  Triple Ring [short, long, short] Single Ring Pitch Tone D Triple Ring [long, short, long] Pitch K

Ring Type 6  Triple Ring [long, short, short] Double Ring Pitch Tone D Triple Ring [long, short, short] Pitch L

Users choose the phone Ring Type Family. The family setting is in the Settings or Config menu
on the phone.

Users of 91xx series and 92xx series phones can choose from five families. The Allworx Verge IP
phone series has 3 additional families. Ringtone Family 1 is the default family for 91xx series and
92xx series phones. Ringtone Family 6 is the default family for the Allworx Verge IP phone series.

Family Ring Type Description

Family 1 Default Frequencies

Family 2 Middle Frequencies

Family 3 High Frequencies

Family 4 Very High Frequencies

Family 5 Varying Frequencies

Family 6 Recorded ring tones with a melodic theme
Family 7 Recorded ring tones with a modern theme
Family 8 Recorded ring tones with a traditional theme

Which Auto Attendant answers the call?
Outside Lines and internal extensions may be programmed to have an Auto Attendant answer
the call. Use Multiple Auto Attendants to give the appearance of different businesses or
different departments within a business. if the call route does not define the specific Auto
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Attendant to use, the answering Auto Attendant is determined by the source of the incoming
call. The table below defines which attendant answers the call based on the source of the call:

Source of Call Answering Auto Attendant
Outside Line - DID Line Auto Attendant x4301
Outside Line - FXO Line (Default Attendant defined for the line)
Outside Line - SIP Gateway (Default Attendant defined for the gateway)
Outside Line - SIP Proxy (Default Attendant defined for the proxy)
Internal Phone Auto Attendant at x4301
4. (optional) Click add a destination and repeat steps 4 and 5 to ring multiple phones

simultaneously.

5. (optional) Click add another connection attempt and repeat steps 4 and 5 to forward the call
to another handset, if the first connection attempt does not answer. Continue repeating, as
required.

6. Locate the Finally... box, and select an option for the call from the drop-down list, if the user or

any of the connection attempts do not answer. To delete any of the connection attempts, click
delete this attempt.

Hang up Requires no further action.

Transfer to Auto Attendant Select an option from the drop-down list.
Transfer to Call Queue Select an option from the drop-down list.
Transfer to Voicemail for user Select an option from the drop-down list.
Dial number Enter a new number to forward the call.

7. Click Add to save the change or Cancel to disregard the request.

11.2 Perform a Search

Locate extensions based on extension, description, login name, or site.

To perform a search:
1. Log in to the Allworx server admin page, and navigate to Phone System > Extensions.

2. Locate the search line and enter the search criteria. Press Enter. The table displays the
information matching the search criteria.

11.3 Manage the Description

Click the description name as a short cut to manage the user. See "To modify or delete existing users:’

U

on page 133 for additional information.
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11.4 Manage Call Routes

The building blocks of a call route are the Connection Attempts and the Finally route. In a typical call
route, there is one Connection Attempt and the Finally route. The Allworx server supports configuring
the call routes for special purpose routing such as:

Presence Specific Routing When on vacation, forward the call directly to voicemail (User extensions).

Multiple Destinations Ring multiple phones simultaneously.

Multiple Connection Attempts Ring a series of phones when the primary phone is not answered.

On Busy Routing Ring alternate phone(s) when the line is busy (User extensions).

Follow-Me Anywhere Forward the call to a cell phone or home phone.

Caller ID Based Routing Separate call route dependent on the Caller ID of the incoming call (User extensions).

Hot Desk Routing Route the call to a logged-in phone after logging into a shared phone. Default is disabled.

To enable users to define the extension routing using the My Allworx Manager page, see “To modify or
delete existing users:” on page 133 for more information.

To manage the presence call route:
1. Log in to the Allworx server admin page, and navigate to Phone System > Extensions.

2. Locate the extension or the user and click View Call Routes. The page displays the presence
settings and associated call route for each setting.

3. Locate the presence setting and click one of the following links:

add new call route Create a call route specific to the user. To update the call route:
1. Locate the Call Route Selection section and check the box or boxes to add the new route to the
selected presence.
2. Use the Caller ID of the incoming call to a User extension to determine the call route.

external - Caller ID enter the phone number with area code in the text box. Use the asterisk
Number as a wild card.

internal - phones select the extension from the drop-down menu.

owned by

3. Locate the Call Route section. Follow the instructions below in add a connection attempt.

Modify Update the current presence call routing. To update the call route:
1. Locate the Call Route Selection section and check the box or boxes to add the new route to the
selected presence.
2. Use the On calls from all callers to determine the call route:

Modify Primary Updates the call route for all calls meeting the external caller criteria.
Route

Modify On Busy This avoids having callers hear a busy signal when calling an extension
Route by configuring an alternative On Busy call route. The system ignores

additional call attempts when configuring the busy route to use a call
route instead of treating a busy call as no answer.

NOTE: Create and save (Update button) the primary call route before creating or modifying the On
Busy Route.
3. Locate the Call Route section. Follow the instructions in add a connection attempt.
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Delete remove the call route from the list. Click Delete Route to remove the call route or Cancel to disregard
the request.
add a Forward the call to another extension. To setup the connection attempt:

connection attempt

1. Locate {no selection} and select an available location* from the drop-down list.

« For Follow-Me Anywhere**: Enter 9 or 78'+PIN (to gain an outside connection) followed by the
phone number in the text box that appears to the right.
Examplest:9+1+aaa-xxx-nnnn, 9+1+xxx-nnnn, 78+ PIN+1+aaa-xxx-nnnn, or
78+PIN+xxx-nnnn
(optional) Select the number of rings from the drop-down list. Click the ring style and select an
option.
. (optional) Click add a destination and repeat steps 1 and 2 to ring multiple phones simultaneously.
. (optional) Click add another connection attempt and repeat steps 1 and 2 to forward the call to
another handset, if alternate phones should ring when the handset(s) in the First connection
attempt are not answered. Continue to repeating step 4, as required.

N

M w

add a
connection
attempt (con't)

5. Locate the Finally... box, and select an option for the call if the user or any of the connection
attempts do not answer.

Hang up

Transfer to Auto Attendant Select an option from the drop-down list.
Transfer to Call Queue Select an option from the drop-down list.
Transfer to Voicemail for user Select an option from the drop-down list.
Dial number Enter a new number to forward the call.

To delete any of the connection attempts, click delete this attempt.

* Hot Desk Routes

Hot Desking enables users to log in to shared phones, receive their calls on that phone, and place calls
with their caller ID. Users can initiate the log in using a Hot Desk PFK or by selecting the Hot Desk Login
option from the phone Config menu.

Users can add Hot Desk destinations manually or automatically to user call routes. If none are present
when the user Hot Desks into a phone, then Hot Desk destinations are added as the first connection
attempt to all Presence call routes.

** Follow-Me
Anywhere

Users can forward calls to other phones outside of the Allworx System such as cell or home phones. If
the recipient does not answer the call, the system directs the call back to the system in order to follow
the rest of the configured call route. In following the rest of the call route, unanswered
Follow-Me-Anywhere calls may eventually be directed to the Finally route, which enables callers to leave
messages in the default voicemail inbox. If the preferred setting is having callers leave messages on a
personal phone voicemail, do not use the Follow-Me-Anywhere features. Instead, use the Finally route
to direct calls to a cell or home phone by entering the phone number into the Dial number text box.
NOTE: When an outside phone answers the call, the default is for the recipient to hear a prompt
requesting to enter a ‘1" to accept the call. However, the Allworx administrator can configure user
extensions so that Follow-Me-Anywhere calls to their extensions require a Message Center password in
order to accept the call.

NOTE: The Follow-Me-Anywhere feature requires the recipient to listen to a message and enter a code.
Therefore, increment the normal number of rings by at least two in order to give the recipient extra time
to answer the call.

7. Click Update to save the changes or Cancel to disregard the request.
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11.5 Delete an Extension

To remove an extension from the directory:

1. Log in to the Allworx server admin page, and navigate to Phone System > Extensions.

2. Locate the extension or the user and click Delete.

3. Review the confirmation and click Delete to remove the extension or Cancel to disregard the
request.

Click here to return to the Install Checklist .
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Chapter 12 Handsets

Handsets manages analog, generic SIP, and ™
Reach handsets, as well as configure an Allworx Prerequisites
phone.

Access Permissions Allworx Server Administrator
Allworx System Administrator

The Handsets web admin page also provides Phone Administrator role

access to manage the Allworx phone
programmable function keys (PFKs) and the Feature Key Required . (Rk”er:ic SIP Handsets
handset preference groups / templates. | eee

12.1 Manage Analog Handsets

Use the following procedures to connect an analog handset to the Allworx server and to manage the
available settings on the Allworx server for the analog handset.

To connect an analog phone via FXS Phone Port:
1. Plug the phone into one of the server FXS phone ports reserved for Inside Phone Extensions.

2. Lift the phone receiver so that the phone is off hook, and refresh the browser window. The
phone displays in the Analog Handsets section of the page.

3. Hang up the phone receiver.

Note: Analog phones plugged into Port Expander FXS ports do not automatically display on the Handsets page. Add the
: analog phones manually.

To manually connect an analog phone:

1. Log in to the Allworx server admin page, navigate to Phone System > Handsets > Analog
Handsets > New Analog Handset. Click the additional information arrow », if necessary. The
Analog Handset page opens.

2. Update the fields.

Port: Automatically filled in.

Owner Select the handset owner from the drop-down list.

Extension Optional. See TIP next to the field for more information.

Caller ID Number Select an option from the drop-down list.

Caller ID Name Automatically populates from Owner selection. Update as necessary.
Description Automatically populates from Owner selection. Update as necessary.

3. Click Add to update the Analog Handset list or Cancel to disregard the changes.
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To manage the settings on an existing analog phone:
1. Log in to the Allworx server admin page, navigate to Phone System > Handsets > Analog
Handsets section. Click the additional information arrow », if necessary

2. Click an option:

G alivworx

Modify Change the current analog handset settings. See “Analog Handset Settings” on page 62 for more
information.
Delete The server removes the analog handset connection. Click Delete to confirm the change or Cancel
to disregard the request.
Ring Click to test the analog handset connection.
3. Click Update to save the changes or Cancel to disregard the request.

Analog Handset Settings

Handset

Phone Type Automatically filled in.

Port: Automatically filled in.

Owner Select the handset owner from the drop-down list.

Internal Caller ID Name

Automatically populates from Owner selection. Update as necessary.

Internal Caller ID Number

Select an option from the drop-down list.

External Caller ID Number

Optional. Enter information as necessary.

External Caller ID Name

Optional. Enter information as necessary.

Description

Automatically populates from Owner selection. Update as necessary.

Phone Status Visibility

* Normal
* Hide Completely
» Hide Status

Dialing Privileges Group

Select an option from the drop-down list.

Handset Features

Hold Music Selection

* Line-In
* None
« moh_supplied.snd

Can Place Calls

Check the box to enable.

Can Receive Calls

Check the box to enable.

Second Call Handling

Identifies how to manage a second incoming call.

* Busy
« Call Waiting
* Not Busy

Message Waiting Stutter Dialtone

Check the box to enable.

Message Waiting Light

Check the box to enable.

Caller ID Display

Check box to enable.
 Caller ID Type | - check the box to enable.
« Caller ID Type Il - check the box to enable.
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Auto Off-Hook Dialing Enter the digits for the Allworx phone to automatically dial every time the user takes the phone off
hook.
Auto Answer DTMF String Enter the DTMF digits sent when the user answers a call. The system sends these digits to the FXS
device as soon as it answers the call. The following characters are available for use:
DTMF Digits Timing Controls Variables
+0-9 « P generates a one second pause + $xN sends the last N digits (0 for all
«A-D  + increases the duration and gap of digits) of the dialed extension
o ¥ all DTMF tones by 50ms + $nN sends the last N digits (0 for all
o # - - decreases the duration and gap of digits) of the DNIS number

all DTMF tones by 50ms

12.2 Manage Allworx and Generic SIP Handsets

Connect an Allworx handset, Reach handset, or generic SIP handset to the Allworx server and manage
the available settings on the Allworx server for the handset.

If installing Generic SIP phones on the server, Internal Dial Plan changes can modify the configuration on the server
such that the Generic SIP phones no longer register.

Note:

To add a handset:
When registering a phone with the server, it displays on the Handsets page with an expiration
date/time to indicate a registered phone.

The Allworx server feature key provides each Generic SIP handset a license to operate. Allworx administrators can add
a small number of handsets without a key (2 on the Allworx 6x12 server, 4 on the Allworx Connect 300 series servers,
6 on the Allworx 6x and Allworx Connect 500 series servers, and 12 the Allworx 48x and Connect 731 servers).

« Available feature keys provide one, five, or 10 licenses each.

- For larger numbers of Generic SIP handsets, install multiple feature keys.

Note:

The Allworx 6x12 server maximum limit is two (2) generic SIP phones; the Allworx 6x12 server does not require a

Note: feature key.

If it is necessary to restart all of the Allworx handsets, click the Reboot Allworx Handsets button.
Clicking this button ends all active calls.

The Allworx server automatically informs the Allworx Partner Portal about registered Verge series
devices to communicate up-to-date phone warranty start dates. This registration happens
automatically when connecting the Verge IP series devices to an Allworx server. Allworx servers also
send a full list of Verge IP series devices to the Allworx Partner Portal once per week. Log in to the
Allworx server admin page, navigate to Phone System > Handsets > SIP Handsets > update Portal,
and then click the Update Portal button.

Allworx Server Administrators not connected to the Internet can manually export phone configuration
information and important to the Portal.
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Allworx users with permissions to the Allworx Portal see the entire Allworx system information in one
place to:

. look up the Allworx system.

. export the Allworx server configuration, and then import it onto the Allworx Partner Portal.
. submit an RMA.

1. Click one of the following links to add a handset:

add new 1. Locate the Allworx Handset section and fill in the fields:

Allworx Handset - -
Owner Select an option from the drop-down list.
Extension* Optional. Creates the extension with a call route to ring the handset.
Caller ID Number Select an option from the drop-down list.
Caller ID Name Enter the name to display on the caller ID.
Description Enter a meaningful name.

2. Locate the Handset Configuration section and fill in the fields.

Model Select an option from the drop-down list.
MAC If there is an incorrect MAC address entry and the phone boots on the
Address network, the server has a duplicate entry for this phone. The Plug and Play

registration continues with the system using the correct MAC address and
does not use the manually entered information. To locate the MAC Address
information on the phone:

1. Press the phone CONFIG soft key. Use the up and down arrows to scroll

to highlight Current Status/Info and press the Select 2 button.
2. Use the up and down arrow buttons to scroll to locate the MAC Address.
3. Press EXIT soft key twice to return to the main screen.

add new If the link is unavailable, purchase more licenses. Fill in the fields:

Allworx Reach Owner Select an option from the drop-down list.

Handset
Extension* Optional. Creates the extension with a call route to ring the handset.
Caller ID Number Select an option from the drop-down list.
Caller ID Name Enter the name to display on the caller ID.
Description Enter a meaningful name.

add new Generic If the link is unavailable, purchase more licenses and fill in the fields:

SIP Handset Owner Select an option from the drop-down list.
Extension Creates the extension with a call route to ring the handset. If selecting an
(Optional) owner other than admin, the server automatically adds the handset to the In

Office call route of the owner. If selecting an extension, the server creates
the extension with a call route to ring this handset. Typically used in the case
of a conference room or lab phone that does not require an owner.

Caller ID Number Select an option from the drop-down list.
Caller ID Name Enter the name to display on the caller ID.
Description Enter a meaningful name.
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add new Generic Locate the Handset Configuration section and fill in the fields.

SIP Handset (con’t) - - - -
Number of Use a single, generic SIP handset to configure multi-port FXS gateways. Enter the
Lines number of gateway ports available on the gateway device (example: 6). This adds

a generic SIP handset for each Call Appearance. Each Call Appearance represents
a different gateway port.

Login ID* Enter a unique Login ID. If no Log in ID is specified, the server generates a Login
ID when creating the handset.

Password* Select the password complexity by clicking the password requirements buttons.
The Allworx server generates a new password upon request based on the
complexity rules, and displays the new password when configuring the Generic
SIP device. For existing Generic SIP devices, the system maintains the current
password until the Allworx administrator requests a new password.

* Login ID and Password are the credentials for the SIP handset to authenticate with the Allworx Server.

« If not specifying a Login ID, the server generates one when creating the handset and generates a handset User ID
automatically.

+ Do not use the same Login ID on multiple phones.

7. Click Add to add the new handset to server or Cancel to disregard the request.

8. FXS gateway only: Click Modify to configure each Call Appearance. For example: the Allworx
administrator can assign users to each Call Appearance.

To perform a search:
Locate handsets based on extension, description, owner, IP Address, or Caller ID.

1. Log in to the Allworx server admin page, and navigate to Phone System > Handsets > SIP
Handsets. Locate the search line.

2. Enter the search criteria. Press Enter. The handsets matching the search criteria display.

To review the configuration:

1. Login to the Allworx server admin page and navigate to Phone System > Handsets > SIP
Handsets. Click the additional information arrow », if necessary.

2. Review the installed Generic SIP phone User IDs.

3. Determine if the registration configuration for each Generic SIP phone is the same or different

from the current User ID on the server Handsets page. If there is a difference, modify the
on-phone configuration to match the new User ID.

Allworx user guides frequently refer to dialing patterns based on the factory default internal dial plan. After making
changes to the dial plan, the My Allworx Manager > Phone Functions tab automatically updates to the new digits.
Distribute this sheet to all end users. See “To manage the Internal Dial Plan:" on page 39 for more information.

Note:

Changing the Operator to something other than “0” does not automatically change the Operator digit shortcut in the
Auto Attendants. If changing the Operator digit, manually update the Auto Attendants shortcuts. See "Auto
Attendants” on page 17 for more information.

Note:
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12.3 Manage Handset Preference Groups and Templates

These procedures describe assigning a Handset Preference Group and applying a Handset Template.

Note:

For Allworx handsets or generic SIP handsets: unregistered handsets display the registration information in gray italic
font while registered handsets display the registration information in the standard black font. Additionally, the last
handset reboot date/time and the last handset SIP registration time display for each handset.

To manage Allworx handset:

1.

Page 66

Log in to the Allworx server admin page, navigate to Phone System > Handsets > SIP
Handsets. Click the additional information arrow », if necessary.

Check the Show boxes for Allworx Handsets and Reach Handsets. The table lists all installed
Allworx desk phones and Reach handsets.

(optional) Click the Bulk Edit side arrow and check the box next to the handset to select it. Then
click one of the following buttons:

Delete Removes the selected handsets from the server.
Assign Changes the Allworx Handset to the newly selected Handset Preference Group.
Apply Changes the Allworx Handset to the newly selected Handset Template.

Review and update the settings per the table below:

Applies to:
Setting Description Allworx  Allworx  Generic
Desk Reach  SIP Phone
Phone App
<Handset Name of the HPG assigned to the phone. Default setting: PBX Station Yes Yes No
Preference (Default). Click the link for the group settings. See “"Manage Handset
Group Name> Preference Groups” on page 73 for more information.
View Modify the current settings. See "To manage the View Yes Yes No
Configuration Configuration:" on page 67 for more information.
Add Call Create another handset Call Appearance. Multiple Call Appearances Yes No No

Appearance  enable handling calls for multiple users with a single phone.
 Every automatically registered phone configuration includes one
Call Appearance and two PFKs assigned to the Call Appearance.

+ Adding a second Call Appearance creates another address to use

in call routes.

1. Click Add Call Appearance.

2. Click Modify for the new Call Appearance, select the user from
the drop-down list, and click Update.

3. Click View Configuration, Programmable Function Keys modify
> Call Appearance change. Select user from drop-down list and
click Done > Update.

4. Locate the handset and click Reboot.

5. Click Phone System> Extensions > View Call Routes > Modify
> add a destination > <user (select the unused Login ID
number)>.
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Applies to:

Setting Description Allworx  Allworx  Generic
Desk Reach  SIP Phone

Phone App

Add Call To specify a different second user: Yes No No
Appearance Example: Administrative Assistant
(con't) The office administrative assistant, Susan Bell, must answer the
phones of two executives: Tom Brown and Lisa Andrews.
« Susan has a Call Appearance for calls to her extension and a
separate Call Appearance for each executive.
 The Allworx administrator adds a Call Appearance PFK for each
executive to Susan’s phone.
« The call route for each executive is set to ring both the executive
handset and the Call Appearance on Susan'’s handset.
+ The PFK corresponding to the executive receiving a call flashes so
that Susan knows which executive line is ringing and can answer
accordingly (e.g. “Good morning, Tom Brown's office...")

Reboot Restarts the phone. If the phone is in use, the reboot begins when Yes Yes No
the phone is idle.
» Reboot Allworx Handsets is available at the top of the SIP
Handsets section to reboot all Allworx phones with one action.
» One handset reboots every 10 seconds until all phones reboot.

Replace Transfers all of the original phone configuration parameters and Yes No No
settings to a new phone.
* Replace a defective handset with a new one. If the replacement has
fewer PFKs than the original handset, the server copies the PFKs
from the original handset, in order from the bottom, left of the
PFKs, up to the number of PFKs on the replacement handset.
 The system replaces original unsupported handset PFK definitions
on the replacement handset with default values.

IP Address IP Address assigned to the handset. If the PC has a network Yes No No
communications path to the phone, click the Handset IP Address link
to open the phone administration page in a separate browser
window; see "Access Phone Web Administration” on page 82 for
more information.

Setup Displays the Reach Installation Assistance website. No Yes No
Modify Modify handset Call Appearance parameters. Yes Yes Yes
Delete Deletes the Call Appearance from the phone. If there is only one Call Yes Yes Yes

Appearance, the server deletes the phone from the system.

Ring Click to verify an operational phone connection. Yes Yes Yes

5. Reboot the phone after changing any settings on the View Configuration page to update the
phone to the new settings using Reboot described above or manually from the phone.

To manage the View Configuration:
1. Log in to the Allworx server admin page, navigate to Phone System > Handsets > SIP
Handsets. Click the additional information arrow w», if necessary.

2. Check the Show boxes for Allworx Handsets and Reach Handsets.
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3.

Click View Configuration to see the SIP handset phone configuration parameters. In addition
to the phone summary information, the following options display:

Handset Preferences Displays the current preference group. Click modify to update the current preference
Group group. See "Manage Handset Preference Groups” on page 73 for more information.
Template Options Save: keeps the current configuration as a template.

Apply: select a different handset configuration.
Programmable Function Adjust the PFK assignment options. Click modify to update the current settings. See
Keys “Manage the Programmable Function Keys (PFKs)” on page 68 for more information.
Interact Appearances Adjust the settings for each appearance. Click modify to update the current setting. See

"To manage the Call Appearance configuration:” on page 73.

Reboot the phone to save changes.

12.4 Manage the Programmable Function Keys (PFKs)

Manage the PFKs (labeled programmable buttons) by describing and assigning a PFK, reordering the
PFK assignments, and managing the Call Appearance configuration.

To manage the PFKs:

1.

Page 68

Log in to the Allworx server admin page, navigate to Phone Systems > Handsets.
Locate the SIP Handsets section, and click the additional information arrow », if necessary.
Click View Configuration in the handset row. The Configuration page displays for the handset.

Locate to the Programmable Function Keys section, and click Modify. Notice the numbered
row in the table corresponding to the individual phone PFK.

Users can assign options to more than 1 column of PFKs. There are links for the left/right sets of
PFK buttons for the Verge IP phones.

(Optional) Click the Show PFK auto-assignment options to manage all unused PFKs at once.
Click one of the following options:

Assigns Commits selected Stations to all unused PFKs. Check the top checkbox to select or deselect all options
at once. Click Assign to save the updates or Cancel to disregard the request.

Reset Updates all the BLF PFKs to unused.

Assign Commits selected Line Appearances to all unused PFKs. Check the top checkbox to select or deselect all
options at once. Click Assign to save the updates or Cancel to disregard the request.

Reset Updates all the Line Appearance PFKs to unused.

Reset All Updates all of the handset PFK definitions to unused.
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6. Click the key number drop-down menu, and select one of the features below for each PFK.

ACD Appearance

Automatic Call Distribution Appearance - users log in and out of the ACD queues. When logged in, the
user receives and answers calls from the ACD queues. Pressing the PFK toggles between temporarily
stopping and starting ACD calls to route to the agent.

Busy Lamp Field
(BLF)

Monitors and dials another specified phone when setting up the BLF function. When pressing the PFK,
the behavior of this function depends upon the station Mode selection.

PBX Behavior The phone dials the designated extension.

Key System Behavior The phone places an intercom connection to the designated phone.
See "Manage Handset Preference Groups” on page 73 to set station Mode.

Call Appearance

Maps to available handset Call Appearances to place or receive calls.

 Supports using each Call Appearance for call routing and for managing calls independently and
concurrently on the same phone.

* Mapping more than one PFK to the same Call Appearance supports multiple active calls to that Call
Appearance at the same time. The Call Appearance does not display as busy to the call route until all
the PFKs defined for that Call Appearance are in use. This is similar to call waiting except the system
uses the PFKs to alert and select a new call.

Example: Busy Receptionist

» Requirements: A receptionist gets many phone calls each hour. She wants to answer each call while
minimizing the possibility of any caller getting a busy signal.

 Phone Configuration: There is one Call Appearance defined on the phone set up with 8 of the phone
PFKs mapping to the phone Call Appearance (remaining PFKs support other functions).

* Discussion:

« The first call comes in, the phone rings and the Call Appearance PFK flashes.
A second call comes in. The phone rings and the second Call Appearance PFK flashes.

« She presses the Hold button to place the first caller on hold and presses the second Call
Appearance PFK to answer the second caller.

» She continues to place callers on hold and answer new calls or switches to another Call Appearance
PFK to continue/terminate calls.

Call Supervision

Enables supervisors to dial in and monitor calls for designated handsets in three modes:

Barge in After connecting the call, both participants in the call hear the supervisor. The
supervisor can transition to silent monitoring by pressing the phone Mute
button.

Whisper (Available only when the receiving handset is a 9202E or 9204/9204G series

handset) — Only the user hears sounds from the supervising phone, not the other
participant. The supervisor MUTE button controls audio going to the user. The
supervisor cannot initiate two-way communications with the other participant.

Silent Monitor ~ Neither party in the call hear the supervisor. The Mute button on the supervisor
handset lights red. The supervisor can speak to the participants of the monitored
call at any time by pressing (disabling) the Mute button.

"

See "Manage Call Supervision” on page 32 for more information.

Emergency Alert

Receive audible and visual alerts when any local or remote handset on the system makes an emergency
call. See “Emergency Alerts and Caller ID” on page 51 for more information.
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Function Does one set of functions:
Centrex Flash Provide an analog hook flash signal to the CO (when connected to a CO line) to
perform flash-related actions such as call transfer. This option is only available on
Allworx 6x, 6x12, or 48x servers.
Headset Turn the Headset on and off. If the handset is off-hook with a headset plugged-in,
this PFK toggles the audio between the headset and the handset.
Note: If using an undefined Headset PFK, the phone speaker button operates the
headset.
Park Place the active call on a system-wide hold. If there are parked calls, the
programmable button displays Parked Calls. Press to retrieve a parked call.
Redial Call the last dialed number. Unless the Line Appearance(s) Use of Dial Plan phone
option is enabled, the system only redials Call Appearance-dialed calls.
Release End the current call but keeps the appearance active, and the dial tone is heard.
Hot Desk Log in to shared phones, receive calls, and place calls using the caller ID.

+ Users can initiate the login using a Hot Desk PFK (the PFK is solid red but goes off after a user logs in)
or using the phone Config menu and selecting the Hot Desk Login option.

« The Hot Desk PFK and all other PFKs remain as originally configured for the phone; configured PFKs
do not change when a new user logs in. Allworx systems with Connect servers load the user’s Person
Contacts after logging in.

Line Appearance

Monitors the status of an outside line, answers incoming calls on that line, and selects the line for
outbound calls. When setting up this function for this PFK, the user specifies the line.

To enable outside lines available for selection:

1. Navigate to Phone System > Outside Lines and go to the Analog (CO) Lines section.

2. Select the Analog (CO) Line, and click Modify.

3. Go to the Outside Line section, and check the Enable Line Appearance check box.

4. Click Update to return to the Outside Lines page.

Unique Allworx Functionality: an enhanced key-system capability relative to SIP devices and Digital
Lines. Any SIP proxy, SIP gateway, or Digital Line (T1) bearer channel made available as Line Appearance
selections when enabled on the respective configuration pages. Through this, the Allworx system
presents a common key-system use model to all external voice circuit facilities including VolP trunks
going to an ITSP.

Messages Monitors the status of a designated handset Message Center voicemail inbox. Press to access the inbox.
The PFK LED lights red to indicate a new message in the monitored inbox. The Allworx administrator
must specify the monitored inbox when setting up the PFK.

Not Used No action. Select this choice to disable a previously defined PFK.

Push to Talk Provides a one-way, walkie-talkie-like capability. The configured PFK accesses a specific handset.

+ The user speaks to the target handset user by holding the PFK down and speaking.
« To respond, the user of the target handset must place a regular call back to the originator.

Queue Alarm

Maps to one of the 10 Call Queues in the system. It notifies the user of the queue activity levels (number
of calls in the queue and/or longest wait time). The administrator can configure the queue alarm to
include an audible alarm with the queue status displayed on the phone LCD.

The PFK lights yellow when there are no logged-in agents in the queue and the queue is set to force
callers to leave the queue when no agents are logged in.
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Queue Appearance  Maps to one of the 10 Call Queues in the system. It automatically monitors the status of a Call Queue
and used to answer calls that are in the queue.Configuration settings:

Call Queue Select one of the available Call Queues from the drop-down list.

Login to queue when  Check the box to enable/disable automatic login after rebooting the phone.
phone reboots

Ring Type Select a unique ring type to distinguish calls to this PFK from other phone
(for more information,  calls.
see "Ring Types” on « When set to No Ring, the Queue Appearance never rings. The agent uses
page 55. the LED to monitor when there are calls in the queue. Press the PFK to
service the next call in the queue.
+ Set to ring (Ring Type other than No Ring) enables the following fields,
which control when the Queue Appearance rings:

« Wait Period: Enter a value (seconds) a call must be in a queue before the
Queue Appearance starts to ring.

* Number of Callers: Enter a value (number of callers) that must be in a
gueue before the Queue Appearance starts to ring.

* Wrap-up Time: Enter a value (seconds) the agent has available after
ending a call before the system makes the agent available to receive the
next ACD queue call. Agents can dismiss/end the wrap up time from the
handset. Reboots the agent phone to apply changes to wrap up time.

» Meet the following conditions for a Queue Appearance to ring:
* Log in to the station.
* Queue Appearance is idle.
+ Reach the wait period of number of callers thresholds.
« Agent is not in the Wrap-up Time.

Ring Group Displays the status of and to answer a Ring Group call. When routing a call to a specified Ring Group, all
phones ring with a PFK defined for that Ring Group. In addition, Allworx administrators can program an
Allworx IP phone to display:
» Multiple Ring Group400 or higher400 or higher per phone to track more than one Ring Group.
« Multiple occurrences of the same Ring Group. This enables a user to take more than one call at a time
from the same Ring Group to avoid missing additional calls while attending to the current call.

Schedule Displays the mode (day or night) of the configured business schedule.
* The LED is off for day mode and solid red for night mode.
+ To configure switching the current mode and greeting of the schedule, see “Schedules” on page 123
for more information.

Shared Appearance  Supports handling a set of one or more PFKs by the system as a single appearance shared across
multiple handsets. All handsets in the Shared Appearance have common access to calls and call
operations within the group of handsets.

« Selecting this PFK assigns consecutive PFKs, one for each Shared Call Appearance line.

« If there are not enough consecutive PFKs available, the PFK assignment fails and an error message
displays.

« If the Shared Call Appearance PFK assignment would overwrite existing PFKs, the system displays an
error message and enables canceling the operation.

« Shared Call Appearance PFKs display consecutively on the PFK configuration page, the Allworx
administrators can move the assignments to different PFKs limited only by the constraints within the
particular handset model.

10.  Locate the next column and click define. Update the PFK settings. The chart below describes the
PFK settings. The Emergency Alert, Hot Desk, and Not Used assignments do not have a define

link.
Audible Alarm Check the box to hear the alarm from the phone speaker.
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11.

12.

13.

Page 72
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Call Appearance

Select an available user from the drop-down list.

Call Queue

Select an available call queue from the drop-down list.

Call Supervision

4

See "Call Supervision” on page 69 for more information.

Contact Leave unassigned for the Allworx user to assign a Contact, or select a contact from the drop-down list.

Function Select which Function to assign from the drop-down list. See “Function” on page 70 for more
information.

Display Only Check the box for the schedule to control the phone display.

Handset Select an available handset from the drop-down list.

Messages Select an available user from the drop-down list.

Outside Line Select an available outside line from the drop-down list.

Monitored Orbits

Check the boxes of the Parking Orbits to monitor. Optional - select all or clear all to check to clear all
check boxes, respectively.

Login to queue when
phone reboots

Check to automatically log the phone into the call queue after each reboot.

Reminder Duration

Enter a time limit for the caller to be in the Parking Orbit before the phone rings again. Enter 0 to
disable.

Ring Group

Select an available Ring Group to assign from the drop-down list.

Ring Type

No Ring - phone does not ring
Single Ring - see “Ring Types” on page 55.
Double Ring - see “Ring Types” on page 55.

Ring Type 1 - see “Ring Types” on page 55.
Ring Type 2 - see "Ring Types” on page 55.

Ring Type 3 - see "Ring Types” on page 55.
Ring Type 4 - see "Ring Types” on page 55.
Ring Type 5 - see "Ring Types” on page 55.

Ring Type 6 - see "Ring Types” on page 55.
AUTO - uses the defined ring type for the call route.

Schedule

Select an available schedule from the drop-down list.

Shared Appearance

Select an available Shared Call Appearance from the drop-down list.

Wait Period

Specify the amount of time for callers to wait in the call queue before the phone rings.

Wrap-up Time

specify the amount of time each agent can spend in wrap-up.

Locate the User Can Edit column. If necessary, check which PFKs Allworx users can modify.

Click Done to save the change or Cancel to disregard the request. Repeat for each PFK, as

necessary.

Use Location column use the icons to adjust the order of the programmable function keys.

1 Move up Shifts the current PFK definition up one position.
1 Move Down Shifts the current PFK definition down one position.
4 Delete Removes the PFK and shifts all PFK definitions below it up by one location. Because of the shift, PFK

definition #1 in each bank of 12 shifts “up” to the bottom (to position number #12) of the bank to
its left. The last PFK definition on the station becomes Not Used (position #12 of the last bank).

1 866 ALLWORX * 1 585 421 3850
www.allworx.com
Revised: 12/21/2016



e allv@ Allworx System Administrator Guide Version 8.2

=g Insert Shifts all PFK definitions below it down by one position. Because of the shift, PFK definition #12 in
each bank of PFKs shifts “down” to the top (to position number #1) of the bank to its right. If the
last PFK on the station (handset or Expander) was in use, its definition will “drop off’ the end of the
list and is no longer configured.

14.  Click Update to save the changes or Cancel to disregard the request.

To manage the Call Appearance configuration:
The Call Appearance on the Allworx phone is for originating and receiving calls and PFKs beyond the
physical keys available on the actual phone.

« Call Appearance « Line Appearance « Ring Groups (formerly known as Call Monitors)

« Shared Call Appearances * Queue Appearance

When routing calls from the Call Appearance to applications within the Allworx System (e.g., Auto
Attendants, Call Queues, or Conference Center), the server uses or overrides the Call Appearance
language, depending on the application language setting. The handset rings when any of these
appearances ring.

1. Log in to the Allworx server admin page, navigate to Phone System > Handsets.

2. Locate the Interact Professional username, and click View Configuration on the specific
handset.

3. Locate the Interact Appearances section, and click Modify. This opens the Interact

Appearances configuration page.

4, Check the boxes to enable the displayed Interact Appearances. Click change to select a new
Ring Type. For more information on Ring Type, see “Ring Types” on page 55.

5. Click Update to save the changes or Cancel to disregard the request.

12.5 Manage Handset Preference Groups

Each Handset Preference Group is a custom configuration of the handset settings and used to
configure many handsets easily and efficiently by assigning handsets to the group. The Handset
Preference Group section displays the available default and custom preference groups.The PBX and Key
System Default groups contain the factory default handset options for the respective modes.

Settings for existing handsets do NOT change in this process.

Note:

Use the following procedures to create, manage, and assign a Handset Preference Group.
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To manage a Handset Preference Group:
1. Log in to the Allworx server admin page, navigate to Phone System > Handsets > Handset

Preference Groups section. Click the additional information arrow », if necessary.

Click Show Handsets assigned to each Handset Preference Group to display the handsets
assigned to each Handset preference group.

2. Select a default group, and click one of the following links:

View Displays the Handset Preference Group current options. Click Modify to update. See "Handset Preference
Group Settings” on page 74 for more information. Click Update to save the changes or Cancel to disregard
the request.

NOTE: The system software does not enable modifying default Handset Preference Groups. Copy a default
Handset Preference Group, and then click View > Modify.

Copy Create a new Handset Preference Group.

Delete Remove the current Handset Preference Group from the server. If the Delete link is unavailable:
1. Click View, and locate the Handsets Assigned To Group section.
2. Click Modify, and deselect all the associated handsets.
3. Click Update, and restart this procedure.

Handset Preference Group Settings
Update the setting by:

. check the box to enable
. enter text or numbers, as required
. click the drop-down arrow and select an option from the list
Applies to
Setting Description Verge 92xx  Reach
series series app
Name Description of the Handset Preference Group. Yes Yes Yes
Audible Dialing Hear DTMF sounds on the handset or speaker when dialing the phone. Yes* Yes* Yes*
Default: Enabled (check in box).
Auto On Hold Place an active call on hold when another call comes in (with a free Call/ Yes* Yes* No
Line Appearance PFK) when pressing the PFK for the new call.
+ Avoids terminating the first call.
» Default: Enabled (check in box).
Auto Retrieve Calls Enables automatic retrieval of a hold call by going off hook. Yes* Yes* No
« If disabled, connect to an open line (if available) when going off hook.
« Default: Disabled.
Call Handoff Timeout Enables the amount of time (in seconds) before canceling the Call Handoff. Yes No Yes
Call History Size* Specifies the number of calls the station keeps in the call history. If Yes*! Yes* No
specifying a value of zero, the phone does not maintain a Call History to
help preserve the privacy of the handset user.
Call Supervision Monitor the handset by another handset with a Call Supervision PFK. Yes Yes No
Default: Enabled (check in box).
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Applies to

Setting Description Verge 92xx  Reach

series series app

Call Timer Display Enables the phone LCD displays call duration timers. Yes* Yes* No
Default: Enabled (check in box).

Caller ID Display Enables the phone to display any caller ID information. Yes Yes No
Default: Enabled (check in box).

Clock Mode Displays phone station clock. Yes* Yes* No
- Off disables the clock display.
* 12-hour format or 24-hour format.

Codec Preference Order Check the box to select the codecs to use.Click and drag the codecs for Yes Yes Yes
the preferred codec usage order. Contact the service provider for the
preferred CODEC order.
6x12, 6x, 48x: CODEC preference choice must include G.711u.
G.722: is not supported for server audio.
This setting defines codec selection order and does not support all codecs
for all call types (example: accessing the Auto Attendant requires G711).
The phone attempts to use the first choice but uses the codec required to
support the call.

Configuration Menu Enables the phone owner to access the configuration menu when securing Yes Yes No
phones located in common areas.

Daylight Saving Time  Specifies if the handset uses Daylight Savings Time (DST) to compute the Yes Yes No
local time.
« Off - does not use DST.
« On - follows US rules for DST.
+ Use current server setting - phone / server are in the same time zone.
NOTE: For remote phones, use the DST setting of the actual location
(available further down the page).

Display Date Format Changes the date display order. Options include: Yes* Yes No
« MM/DD/YY
* YY/MM/DD
+ DD/MM/YY
NOTE: If the phone does not display the year (e.g., 9202e phone), the
month and day matches the order of the selection without the year.

Display Language Changes the Allworx phone display language. Yes Yes No
« Requires Allworx System Software 7.6.6.5 or later.
 Requires the Dual Language Support feature key. The phone defaults to
English during a Factory Reset, functional test mode, or if the Dual
Language Support feature key is unavailable.
» Not available to change the phone display language within the phone
configuration menu.

DTMF Playout Send DTMF digits during an active call. Yes Yes Yes
Default: Enabled (check in box).

Handset Network Select Handset Network Profile Template from the drop-down list to Yes Yes No
Template download to the handset.
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Applies to
Setting Description Verge 92xx  Reach
series series app
Hold Button Mode* Controls the behavior of the phone Hold button: No Yes* No
* Hold Calls, Park Lines - holds calls on Call Appearances. Parks